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使⽤上のご注意 
安全上のご注意 
安全にお使いいただくために 
ご使⽤前に必ずこの取扱説明書をよくお読み下さい。 
この取扱説明書は、いつでも⾒られるところに必ず保
管して下さい。 
本機で撮影した映像、画像は診断で使⽤できません。 
 
シンボル 
この「安全上のご注意」および製品の使⽤説明では、
⼈⾝への危害や財産への損害を未然に防ぎ、正しく安
全にお使いいただくために、さまざまな記号を使⽤し
ています。これらのシンボルとその意味を以下に⽰し
ます。必ずご理解の上ご利⽤下さい。 
 

危険: 
 

この表⽰を無視して、誤った取り扱いをする
と、⼈が死亡または重傷を負う危険が切迫し
て⽣じることが想定される内容を表⽰して
います。 

警告: 
 

この表⽰を無視して、誤った取り扱いをする
と、⼈が死亡または重傷を負う可能性が想定
される内容を表⽰しています。 
 

注意: 
 

この表⽰を無視して、誤った取り扱いをする
と、⼈が障害を負う可能性が想定される内容
および物的損害のみの発⽣が想定される内
容を⽰しています。 

 
(注)  記号は「注意喚起」を促す内容を告げるものです。 
 
表⽰例 

は禁⽌の⾏為であることを告げるものです。図
の中や近傍に具体的な禁⽌内容(左図の場合は分
解注意)が描かれています。 

● は⾏為を強制したり指⽰する内容を告げるも
のです。図の中に具体的な注意内容 
(左図の場合は電源プラグをコンセントから抜け)
が描かれています。 

これは付属⽂書を操作者に助⾔するためのもので
す。 

これはスタンバイを意味します。 

 

警告 
使⽤中 

本機の上に⽔などの⼊った容器、⼩さな⾦属物を置か
ない! 
中に⼊り込むと、⽕災・感電の原因になります。
表⽰された電源電圧以外は使⽤しない! 
⽕災・感電の原因になります。 
本機の開⼝部から⾦属物や燃えやすいものなどの異
物を差し込まない!落とし込まない! 
⽕災・感電の原因となります。 
本機を改造しない! 
⽕災・感電の原因になります。 

感電の危険を避けるために、この装置は保護アース付
きの主電源のみを使⽤する必要があります。
本機は電源スイッチを備えていません。 
主電源から完全に遮断するには電源プラグを抜く必
要があります。

 
設置のとき 

 不安定な場所に置かない︕ 
落下、転倒によりけがの原因になります。

 指定された機器以外とは接続しない︕  
⽕災・感電の原因になります。  
商⽤電源以外には接続しない︕ 
・電撃の危険を回避するため、この機器は保護接地

を備えた電源(商⽤)だけに接続すること。 
・必ずアース付きの電源コンセントに接続するこ

と。
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異常が発⽣したとき 

 
 

煙が出ている、異臭、異⾳などの異常な状態になった
場合、すぐにスタンバイ状態にし、電源プラグを抜
く︕ 
そのまま使⽤すると、⽕災・感電の原因となります。
煙が出なくなるのを確認して、販売店または営業担当
にご連絡下さい。 

 
 

内部に⽔や異物などが⼊った場合、すぐにスタンバイ
状態にし、電源プラグを抜く︕ 
そのまま使⽤すると、⽕災・感電の原因となります。
販売店または営業担当にご連絡下さい。 

 
 

本機を落としたり、ケースが破損したりした場合は、
スタンバイ状態にし、電源プラグを抜く︕ 
そのまま使⽤すると、⽕災・感電の原因となります。
販売店または営業担当にご連絡下さい。 

 
 

本機が故障した場合は、スタンバイ状態にし、電源プ
ラグを抜く︕ 
そのまま使⽤すると、⽕災・感電の原因となります。
販売店または営業担当にご連絡下さい。 

 

傷んだ（芯線の露出・断線など）電源コードは使⽤し
ない︕ 
そのまま使⽤すると、⽕災・感電の原因となります。
販売店または営業担当にご連絡下さい。 

 

注意 
ご使⽤になるとき 

 
本機の上に重いものを置かない︕ 
バランスが崩れて倒れたり、落下して、ケガの原因に
なることがあります。 

 
本機やキャリングケースに乗らない︕腰掛けない︕ 
壊れたり、倒れたりして、ケガの原因になることがあ
ります。 

 

移動させる場合は、スタンバイ状態にして、電源コー
ドを抜く、機器間の接続ケーブルを外す、を必ず⾏な
って下さい︕ 
コードが傷つくと、⽕災・感電の原因となることがあ
ります。 

 
稼動を停⽌させる場合は、必ずスタンバイ状態にして
から、電源プラグを抜く︕ 
壊れたり、⽕災・感電の原因となることがあります。

 
⻑時間使⽤しないときには、安全のため、必ず電源プ
ラグをコンセントから抜く︕ 
⽕災の原因となることがあります。 

設置のとき 
本機の通⾵孔をふさがない︕ 
通⾵孔をふさぐと内部に熱がこもり、⽕災の原因にな
ることがあります。次のような使い⽅をしないで下さ
い。  
・仰向け、逆さまにする。 
・通⾵孔を塞ぐような縦置きにする。 
・⾵通しの悪い狭いところに押し込む。 
・じゅうたんなどの上に置く。 
・テーブルクロスなどをかける。 
⾼温機器を傍に置かない︕ 
影響を受けて強制停⽌することがあります。 
電源プラグの抜き差しが困難な場所には置かない︕ 
コードが傷つき、⽕災の原因になることがあります。
切り離しの妨げにならないような設置をして下さい。
ケーブルに負担がかかる場所には置かない︕ 
折る、ねじる、などケーブルに著しい負荷をかけると
コードが傷つき劣化、断線、⽕災の原因になります。
カメラヘッドをアダプタ及び顕微鏡へ固定する場合、
次のことにご注意下さい。嵌合が不⼗分だと、使⽤中
に落下するおそれがあり、落下により死傷する恐れが
あります 
・カメラヘッドをアダプタのＣマウントリングにし

っかりとねじ込んで嵌合させて下さい。 
・顕微鏡のビームスプリッターにアダプタを取付

け、付属締付リング⼜はアダプタ付属締付リングを
確実に締め付けて下さい。 

・使⽤前に、嵌合がゆるんでいないか確認下さい。
 
 
設置のとき 
・湿気やほこりの多いところ、油煙や湯気があたるところを避

けて設置して下さい。 
感電の原因になります。 
また調理台や加湿器のそばなどには置かないで下さい。

・不意の地震や衝撃などによる転倒を防⽌して下さい。 
本機が倒れてケガをするおそれがあります。安全のため、転倒
防⽌対策を⾏って下さい。 

 
 
  



3 
 

カメラケーブルについて 
次のことにご注意下さい 
・必ず専⽤のカメラケーブルをご使⽤下さい。 

誤って別のカメラケーブルを接続すると破損する恐れがあ
ります。 

・カメラケーブルをカメラヘッドやＣＣＵから外すときは、絶
対にケーブルを引っ張らずに、コネクタ（プラグ）を持って
抜いて下さい。 

・ケーブルを押しつぶさないで下さい。  
・電源を⼊れたまま、カメラケーブルの抜き差しをしないで下

さい。 
・カメラケーブルの許容曲げ半径は、ケーブル外径⼨法の約

10 倍（φ7.5mm のケーブルの場合、75mm）です。 
それ以上無理に折り曲げないで下さい。無理に曲げようとす
るとケーブル内部の線材が断線する場合があります。 

 

・カメラヘッドを、回転台等に固定して使⽤する場合、可動さ
せてもケーブルに無理な⼒が加わらないように、カメラケー
ブルをクランプして下さい。キンク（よじれ、うねり）しな
いように注意して下さい。キンクしたまま使⽤すると、ケー
ブル内部の線材が断線する場合があります。 

・使⽤前に、ケーブル及び束線材の損傷や劣化がないか確認し
て下さい。 

 
お⼿⼊れについて 
・お⼿⼊れの際は安全のため、スタンバイ状態にし、電源プラ

グを抜いてから⾏って下さい。感電の原因になります。 
・筐体やパネルの汚れは、乾いた柔らかい布で軽くお拭き下さ

い。 
・⻑く安定した性能を維持するために“定期的な点検”をお勧

めします。定期的な点検は営業担当にご相談下さい。 
・内部に⾼電圧部分があるため、点検・整備・修理は、この様

な製品の知識を有する者が⾏って下さい。感電による事故の
原因になります。 

 

点検について 
本機を安全にお使いいただくため定期的な点検を推
奨します。 
 
使⽤者による保守点検（⽇常点検） 
① ⽬視による確認 
(1) 外観の確認 

・装置の外観、ケーブルに損傷や磨耗等の異常がないこ
とを確認すること。 

(2) 清浄性の確認 
・清浄な状態であることを確認すること。  
・天板等に被検者の体液、⾎液、汚物及び造影剤等が付着

していないこと。 
(3) 装置周辺の確認 

・装置の妨げになる物がないこと。 
・通⾵孔が塞がれていないことを確認すること。 

 
② 機能の確認 
(1) 装置の正常状態の確認  

・装置の正常状態・正常動作を確認すること。 
・異⾳、異臭がないことを確認すること。 

(2) 装置の固定状態の確認 

 
 
 
 
 
 
 
 
 
 

  

半径 75mm 以上 

カメラヘッド 

半径 75mm 以上 

コネクタ 

カメラケーブル 
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点検⼀覧 

警告 
本機を使⽤する⼈は、必ず適切な説明を受けてから操作や作業
を⾏って下さい。 
説明を受けていない⼈が操作すると誤操作のおそれがあり、画
像の劣化等、充分な性能が得られないことがあります。 

 
点検内容 
本機の運⽤前には必ず次のことをご確認下さい。 
(1) ⽬視確認 

・ 電源が⼊るとスタンバイスイッチが点灯します。 
(2) 外観チェック 

・ カメラヘッド 
・ CCU 
・ カメラケーブル 
・ 接続機器との接続ケーブル 
・ AC からの電源供給 
・ 冷却ファンの回転 
・ 前⾯操作パネルの表⽰及び動作が正常であること 
・ ⼿術顕微鏡、アダプタ、カメラヘッドの勘合 
・ すべての構成品に破損や磨耗が無いこと 
・ 周辺機器と正しく接続されていること 

 
破棄について 
廃棄する時には、地⽅⾃治体の条例または規則に従って処分し
て下さい。詳しくは各地⽅⾃治体にお問い合わせ下さい。
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EMC に関する重要なお知らせ 
SP-FrexHD X5 は EMC に関する特別な注意が必要であり、取扱説明書中に記載されている EMC 情報に従って
設置と操作をする必要があります。 
 

警告 
 SP-FrexHD X5 を他の機器の横に置いたり、積み重ねたりして操作する場合は、その使⽤構成で正常に動作

していることを確認する必要があります。不適切であると SP-FrexHD X5 性能低下を招くことがあります。 
 SP-FrexHD X5 に接続するすべてのケーブルはシールドする必要があります。 
 近くでポータブル RF 通信機器を使⽤する場合は、少なくとも 30 cm の距離を維持してください。これよ

り短い距離では、機器の性能が低下する可能性があります。 
 この取扱説明書によって指定されたもの以外のアクセサリ デバイスまたはケーブルを使⽤すると、エミッ

ション（電磁妨害の放射）増加やイミュニティ（電磁妨害の耐性）低下を招くことがあります。 
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指針及び製造業者の宣⾔-電磁エミッション

SP-FrexHD X5 は下記に規定した電磁環境での使⽤を意図しています 
お客様、⼜は SP-FrexHD X5 の使⽤者は、それが下記の環境で使⽤される事を確認して下さい。 

エミッション試験 適合性 電磁環境 指針 
RF エミッション 

CISPR 11 
 

 
グループ１ 

 

SP-FrexHD X5 は、内部機能のためだけに無線周波エネルギーを使⽤しています。
そのため、無線周波エミッションは⾮常に低く、近傍の電⼦機器を妨害すること
は、ほぼありません。

RF エミッション 
CISPR 11 

クラス A 
 

SP-FrexHD X5 は、下記を除く全ての施設での使⽤に適しています。 
 
除くのは、家庭施設及び家庭⽬的に使⽤される建物に電⼒を供給する公共の低電
圧⽤の配電網に直接接続されている施設です。 
 
 

⾼調波 エミッション 
IEC61000-3-2 

クラス A 
 

電圧変動 / フリッカ 
エミッション 

IEC61000-3-3 

適合する 
 

 
 

指針及び製造業者の宣⾔-電磁イミュニティ
SP-FrexHD X5 は下記の電磁環境での使⽤を意図しています 
お客様、⼜は SP-FrexHD X5 の使⽤者は、それが下記の環境で使⽤される事を確認して下さい。 

イミュニティ 
試験 

IEC 60601 
試験レベル 

適合 
レベル 

電磁環境 指針 

静電気放電 
(ESD) 
IEC61000-4-2 
 

±8kV 接触 
 
±15kV 気中 

±8kV 接触  
 
±15kV 気中 

床材は⽊材、コンクリート⼜は陶製タイルとして
下さい。 
床材が合成物質で覆われている場合、相対湿度が
少なくとも 30%以上である事を条件とします。 

電気的ファスト 
トランジェント /  
バースト 
IEC61000-4-4 
 

±2kV 電源線 
±1kV ⼊出⼒線 

±2kV 電源線 
±1kV ⼊出⼒線 

電源の品質は、典型的な商⽤⼜は病院環境のもの
を利⽤して下さい。 
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指針及び製造業者の宣⾔-電磁イミュニティ
SP-FrexHD X5 は下記の電磁環境での使⽤を意図しています 
お客様、⼜は SP-FrexHD X5 の使⽤者は、それが下記の環境で使⽤される事を確認して下さい。 

イミュニティ 
試験 

IEC 60601 
試験レベル 

適合 
レベル 

電磁環境 指針 

サージ 
IEC61000-4-5 

 

±1kV 線対線間 ±1kV 線対線間 電源の品質は、典型的な商⽤⼜は病院環境のもの
を利⽤して下さい。 
  
 ±2kV 線対接地間 ±2kV 線対接地間 

電源⼊⼒ラインでの電圧
ディップ、瞬停及び電圧
変動 
IEC61000-4-11 
  
  
  
  
  
  
  

電圧ディップ 
0% Ut

電圧ディップ 
0% Ut

電源の品質は、典型的な商⽤⼜は病院環境のもの
を利⽤して下さい。 
SP-FrexHD X5 の使⽤者が、停電中も継続し運⽤
する事が必要な場合は、無停電電源装置⼜はバッ
テリから SP-FrexHD X5 に電源供給する事を推奨
します。 
  
  
  
  
  
  
  
  
  

(100% Ut のディップ) (100% Ut のディップ)
0.5 サイクル間 
 
0% Ut 
(100% Ut のディップ) 
1 サイクル間 

0.5 サイクル間 
 
0% Ut 
(100% Ut のディップ) 
1 サイクル間

  
70% Ut 70% Ut
(30% Ut のディップ) (30% Ut のディップ)
25 サイクル間 25 サイクル間
 
瞬停 

 
瞬停

0% Ut 0% Ut
(100% Ut のディップ) (100% Ut のディップ)
250 サイクル間 250 サイクル間 

電源周波数 
(50/60Hz) 磁界 
IEC61000-4-8 
 

30 A/m 
 
 
 
 

30 A/m 
 
 
 

電源周波数磁界は、典型的な商⽤⼜は病院環境内
の典型的な場所での特性レベルである必要があり
ます。 
 

備考  “Ut” は試験レベルを加える前の交流電源電圧です。
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指針及び製造業者の宣⾔-電磁イミュニティ
SP-FrexHD X5 は下記の電磁環境での使⽤を意図しています 
お客様、⼜は SP-FrexHD X5 の使⽤者は、それが下記の環境で使⽤される事を確認して下さい。 
 

イミュニティ 
試験 

IEC 60601 
試験レベル 

適合性 
レベル

電磁環境 指針 
 

    

携帯形及び移動形の無線通信機器は、ケーブルを含む SP-
FrexHD X5 のどの部分に対しても、無線通信機器の周波
数に対応した式から計算された推奨分距離以下に近づけ
て使⽤しないで下さい。 

    
 
推奨分離距離

伝導性妨害 
IEC61000-4-6 

3 Vrms 
150kHz 〜 80MHz 
ISM 帯域外 
 
6Vrms 
150kHz 〜 80MHz 
ISM 帯域内 
 
 

3 Vrms 
  
 
 
6 Vrms 
 
 

d=1.2√P 
  

放射性妨害 
IEC61000-4-3 

3 V/m 
80MHz〜2.7GHz 

3 V/m d=2.0√P    80MHz 〜 2.7GHz 

  
ここで P は、送信機器メーカーが指定した送信機の最⼤
出⼒定格を表し単位はワット（W）です。

    ｄは推奨分離距離で単位はメートル（ｍ）です。

  

 
固定の無線送信機からの電磁界強度は電磁気の現地調査
によって決定されますが、これは各周波数範囲において
適合レベル未満である必要があります。 
次の記号が表⽰された機器の近くでは、⼲渉が⽣じる可
能性があります。

  
  
  
備考 1  80 MHz 及び 800MHz においては、⾼い⽅の周波数範囲を適⽤します。 
備考 2  これらの指針は、全ての状況に適⽤するとは限ません。  

電磁気の伝搬は、建物、物体及び⼈体による吸収や反射の影響を受けます。
 

 ※a 固定の無線送信機、例えば、無線(携帯/コードレス)電話基地局及び陸上移動無線、アマチュア無線、 

     AM 及び FM ラジオ放送及び TV 放送からの電磁界強度は、理論上、正確には予測する事ができません。  

     固定の無線送信機に起因する電磁環境を評価する為に、電磁気の現地調査を考慮する必要があります。 

     SP-FrexHD X5 が使⽤される測定電磁界強度が適⽤される上記の無線適合性レベルを超える場合、 SP-FrexHD X5 が正常に動作してい

る事 

を確認して下さい。 

     もし異常な動作が観測される場合、SP-FrexHD X5 の向きや場所を変えるといった追加措置が必要になる事があります。 
  ※b 周波数範囲が 150 kHz〜80 MHz において、電界強度は 3V/m 未満である必要があります。 
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ご使⽤にあたっての注意事項 

電源ケーブル 
・ 付属品をご使⽤下さい。 
・ 下記の部分にフェライトコア（付属品︓E04SR200935A）1 個を緩みがないことを確認して取り付けて下

さい。 
  取り付けに不備があると⼿術中に外れたりして思わぬ事故に繋がる危険があります。 
 

 

 
SDI ケーブル 
・ 接続実績の無いケーブルは、事前に接続チェックを⾏なって下さい。 

 
HDMI ケーブル 
・ HDMI ケーブルをご使⽤下さい。 
・ 接続実績の無いケーブルは、事前に接続チェックを⾏なって下さい。 
・ 映像が映らない場合、HDMI ケーブルを⼀度外し再接続して下さい。改善しない場合は違う HDMI ケーブ

ルをお使い下さい。 
 
カメラケーブル 
CCU 背⾯のカメラケーブルの接続⼝は次の通りです。

・ 挿⼊⽅向が合っていることを確認のうえ必ず真っ直ぐに接続して下さい。 
・ 回す、ねじる等の⾏為をしながらの接続はしないで下さい。 
・ 接続後にカメラケーブルのコネクタは回さないで下さい。 

 
フットスイッチ 
・ 本機に接続するフットスイッチは IEC60601-1 適合製品をご使⽤下さい。
・ 本機に接続するフットスイッチを除くその他の製品は IEC60601-1 ⼜はその機器に該当する安全規格

（IEC 規格、JIS 規格、PSE 等）の適合製品をご使⽤下さい。 
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USB 
本機の USB ポートは以下の⾏為には対応していません。これらを⽬的には挿さないで下さい。 
・ 録画  
・ 給電 
・ 外部機器との通信 

USB メモリーの接続を認識するまで、データの書き込み/読み出し処理、の最中に下記の⾏為は絶対に⾏なわ
ないで下さい。データの破損や損失、USB メモリーが認識しなくなる、などの原因になります。 
・ USB メモリーを本機から取り外す 
・ 電源ケーブルを抜く 

本機に使⽤する USB メモリー内のデータは必ずバックアップを取って下さい。データの破損を引き起こす⾏
為が⾏なわれたことで⽣じた損失に対して当社では⼀切の責任を負いかねます。 
USB メモリーについて 
・ パスワードによる保護機能を有するものはご使⽤できません。 
・ ファイルシステム FAT32 でフォーマットされたものをご使⽤下さい。 
・ 認識しない、動作しない場合は別の USB メモリーをお使い下さい。 

 
医療機器との併⽤について 
本機は電気メスなど⾼周波の電流が流れる機器と同時に使⽤すると、映像の乱れやゆがみ、正常に動作しなく
なる、などが起こる可能性があります。 
本機と電磁的影響を与える可能性のある機器及びケーブルとは近接しないように離し、予め誤動作が起きない
ことを確認のうえご使⽤下さい。 

 
その他周辺機器 
本機と接続される IEC60601-1 に適合していない全ての商⽤電源で動作する周辺機器は、IEC60601-1 に適
合した絶縁トランスを追加し、それを経由して商⽤電源に接続して下さい。
本機はごく微量の電磁波を周囲に放射する可能性があります。取扱説明書に従って設置使⽤されない場合、他
の周辺機器が電磁波障害を引き起こすことがあります。 
 
本機が電磁波障害を引き起こしていると判断された場合は次を実施下さい。 
・ 本機を電磁波障害を受けている機器から出来る限り離して下さい。 
・ 本機と電磁波障害を受けている機器を異なる電源系統のコンセントに接続して下さい。 
本機は周辺機器から電磁波の影響を受ける可能性があります。 
周囲からの影響を受けてノイズや映像乱れを引き起こしている、あるいはその疑いがある場合は次をお試し下
さい。 
・ 電磁波を放射している機器や配線から本機および本機に接続するケーブルを出来る限り離して下さい。 
・ 本機を電磁波を放射している機器の電源系統とは異なるコンセントに接続して下さい。 
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設置 
必ず次の条件を守って設置して下さい。 
 
【設置条件】 
・ CCU は周囲を壁などから 1.5cm 以上離して設置してください。 
 

 
 
 
 
 
 
 

注意 
次の環境に⻑時間放置しないで下さい。機器の劣化や動作不全につながります。 
・ 周囲温度 0℃以下の場所 
・ 湿度 90%以上の場所 
・ 直射⽇光のあたる場所 

 
本書の内容について 
製品の仕様変更などにより予告なく変更される場合があります。初期値など情報は本書作成時点のものであ
り、その後変更になっている場合があります。従いましてご購⼊品と本書の内容が異なることがあります。あ
らかじめご了承下さい。 
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製品概要 
本製品は、⾼⾊再現・⾼感度３CMOS センサー搭載の
フルハイビジョンカメラです。1920 x 1080 の 2K 出
⼒、⽔平解像度 1000TV ライン、S/N ⽐ 63dB を備
えています。 
 

各部の名称 
機能については各詳細ページをご覧下さい。 
 
カメラヘッド                                  

 
1 レンズマウント部 
2 IRIS 端⼦ 
3 カメラケーブル端⼦ 
 
CCU（カメラコントロールユニット）前⾯パネル   

 
1 スタンバイスイッチ 
2 画⾯静⽌ランプ 
3 ホワイトバランスボタン 
4 明るさ⾃動ボタン 
5 ファンクション（F1/F2）ボタン 
6 カラーバーボタン 
7 メニューボタン 
8 ⾊補正ツマミ(⾚) 
9 ⾊補正ツマミ(⻘) 
10 明るさ補正ツマミ 
11 ▲/▼/◀/▶ ボタン 
12 USB ポート(Type A) 

CCU（カメラコントロールユニット）背⾯パネル   
 

 
1 RS-232C 端⼦ 
2 FOOT SWITCH 端⼦ 
3 CAMERA 端⼦ 
4 等電位端⼦ 
5 HDMI 出⼒端⼦ 
6 3G/HD-SDI 出⼒端⼦ 
7 GENLOCK 端⼦ 
8 SYNC 端⼦ 
9 電源端⼦ 
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接続 
本機のカメラヘッドと CCU の間をカメラケーブルで
つなげます。 
 
1 本のカメラケーブルで届かない場合は延⻑⽤のカメ
ラケーブルを使⽤することで延⻑が可能です。 
 
注意 
本機をスタンバイ状態もしくは、電源ケーブルを抜
いた状態でカメラケーブルを接続してください。 

当社が動作保証するケーブルパターンでの使⽤を
お守り下さい。 
保証外の組み合わせで使⽤した場合、映像が映らな
い、映像が乱れる、などのトラブルが起こります。
動作保証するケーブルパターンは営業担当にお問
い合わせ下さい。 

本機を異なる機種のカメラヘッドや CCU とは接続
しないで下さい。異なる機種に接続した場合は機器
が故障する可能性があります。 
回す、ねじるなどの⾏為をしながらの挿抜は絶対に
しないで下さい。ピンが折れるおそれがあります。

 
カメラケーブルをカメラヘッドに接続する 

 

① カメラヘッド端⼦の凸とカメラケーブルの丸型
コネクタの凹を合わせて差し込む。 
 

② カメラケーブルのコネクタを回して締める。 
 

カメラケーブルを CCU に接続する 

 
カメラケーブルを CCU 背⾯のカメラケーブル 
差し込み⼝に接続します。 

カメラケーブル差し込み⼝の凹とカメラケーブルの
プラグの凸をコネクタに塗布されている⾚丸が上向
きになるように位置を合わせてまっすぐ差し込む。 

 
カメラケーブルどうしの接続 

 
カメラケーブルの CCU 側コネクタの凹と延⻑ケーブ
ルのコネクタの凸が合わさるように位置を合わせて
まっすぐ差し込む。 

  

⾚丸 
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ビデオモニターに接続する 

 
CCU 背⾯パネルの出⼒端⼦（SDI、HDMI）からカメ
ラ映像が出⼒されます。 
ビデオモニターと接続することでカメラの出⼒映像
が確認できます。 

 
メモ 
本機の出⼒端⼦とビデオモニターの⼊⼒端⼦とを直
接ケーブルで接続して下さい。変換アダプタ等を使⽤
すると映像が表⽰されないことがあります。 
 
 

 
 
SDI で接続する 
 

 
 
HDMI で接続する 
 

 

・ HD-SDI または 3G-SDI ⽤ケーブル 
(別売)を⽤意する。 

 
 
 
 

 
 
・ CCU 背⾯の 3G/HD-SDI 出⼒端⼦とビデ

オモニターの SDI ⼊⼒端⼦を SDI ケーブ
ルでつなぐ。 

・ HDMI ケーブル※(別売)を⽤意する。 
 
 
 
 

 
 

※HDMI 規格に準拠していないケーブルでは 
動作保証しておりません。 

 
・ CCU 背⾯の HDMI 出⼒端⼦とビデオモニタ

ーの HDMI ⼊⼒端⼦を HDMI ケーブルでつ
なぐ。 
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電源 
準備 
1. CCU にカメラヘッドやビデオモニター等の外部

装置が正しく接続されていることを確認して下
さい。 
 

2. ビデオモニター等の外部装置の電源を⼊れて下
さい。 

 
電源を⼊れる 

1. 付属の電源ケーブルを CCU 背⾯の電源端⼦に接
続する。 

 
 
 
 
 
 
 
 
 
 
 

注意 
電源ケーブルをコンセントから抜いた状態で⾏っ
て下さい。 

 
2. 電源ケーブルのプラグをコンセント(主電源)に差

し込む。 
 
3. CCU 前⾯のスタンバイスイッチを押す。 

スタンバイスイッチが⽩⾊に点灯し、起動します。 

 
4. 最後に本機を使⽤した設定での映像がビデオモ

ニターに出⼒されます。 
 
 

電源を切る 

1. 再度 CCU 前⾯のスタンバイスイッチを押す。ス
タンバイスイッチが消灯し、スタンバイ状態にな
ります。 

 

 
2. ビデオモニターから本機の映像が消えます。 

 
3. コンセントから電源ケーブルのプラグを抜く、あ

るいは主電源から遮断すると本機の電源が完全
に切れます。 

 
スタンバイ状態について 

スタンバイ状態は起動中に⽐べて本機の電⼒を抑え
られます。 
 
  を奥に押し込むと本機は起動します。 
（起動） 
 
再度  を押して定位置に戻すと本機は停⽌します。 
（スタンバイ状態） 
 
注意 
周辺機器を本機につなぐ、取り外す際はスタンバイ
状態にしてから⾏なって下さい。 
起動中に抜き差しすると設定やデータが失われる
恐れがあります。 
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操作 
本機の設定を変更する場合はメニューボタンを押し、
ビデオモニターに表⽰されるメニュー画⾯を⾒なが
ら操作します。 
メニュー画⾯の表⽰・⾮表⽰はメニューボタンを押し
て切替えます。 
 
メニュー画⾯を表⽰する・閉じる 

1. 前⾯パネルのメニューボタンを押す。 
(メニュー画⾯の表⽰) 

 
2. ビデオモニターにメニューのトップが表⽰され

ます。 

 
3. メニューボタンをもう⼀度押すとビデオモニタ

ーからメニューの表⽰が消えます。 
 
注意 
変更した設定はメニュー画⾯を⼀度閉じることで
保存されます。 
メニュー画⾯を表⽰した状態で本機の電源を切る、
スタンバイ状態にした場合、変更を加えた設定情報
は失われます。 

 

操作/実⾏ 

 

 
▲▼︓カーソルの上下移動、設定の変更 
◀▶︓カーソルの左右移動、ページ間移動 
決定︓機能実⾏ 
 
カラーバー 

前⾯パネルのカラーバーボタンを押すとビデオ出⼒
がカラーバーになります。もう⼀度押すとカラーバー
は消えます。 
 

 
ホワイトバランス 

ホワイトバランスボタンを押すとオートホワイトバ
ランス(AWB)が実⾏されます。(→P36) 
 

 
 
  

PICTURE 
Brightness 
Contrast 
Color 
Sharpness 
Scene File 

FUNCTION 
Function 
Foot Switch 
Function Key 

SYSTEM 
Video Format 
Date/Time 
Others 
Information 
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明るさ⾃動調整 

明るさ⾃動ボタンを押すと出⼒映像の明るさが⾃動
的に調整されます。(→P27) 
 

明るさ補正ツマミ 

左右に回すことで明るさ⾃動調節時の出⼒映像の明
るさを調整できます。(→P27) 
 

⾊補正ツマミ(⾚)/⾊補正ツマミ(⻘) 

ホワイトバランス調整後の⾊合いを調整します。左右
に回すことで⾚⾊の濃さと⻘⾊の濃さを調整できま
す。(→P35) 
 

ファンクションボタン 

よく使う機能を予め F1/F2 ボタンに割り当てること
ができます。（→P54） 
 

USB ポート(Type A) 

USB ポートです。USB メモリーに本機の設定値デー
タを保存したり、USB メモリー内の本機の設定値デー
タを読み出して反映させることができます。（→P62） 
 

状態に応じてビデオモニターにメッセージが表⽰さ
れます。 
 
USB メモリー認識中/読み込み中/保存中 

 

処理が正常に完了 
 
処理が正常に完了できなかった場合はエラーメッセ
ージが表⽰されます(→P86)。 
 
 
 

 
 
 
 
 
 
 

USB Memory Busy 

 
 
 
 
 
 
 

USB Memory Completed 
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メニューツリー 
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※1︓オプション機能(有償)のみ表⽰ 
※2︓[CCU Type]が[Slit]のとき⾮表⽰ 
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PICTURE 
Brightness               

ビデオモニターに出⼒した映像の明るさを調整する項⽬です。 
 

 
Item Setting value Description

Response  [Shutter][Gain][Iris Control]が AUTO 時、それらの設定から最適な明る
さに⾃動調整されるまでの早さの設定をします。 
詳細→ユーザーガイド

 FAST 早く 

MIDDLE 標準 

SLOW ゆっくり 

Photometry Measurement 
Area 

測光エリアの範囲を設定できます。表⽰された枠内の光量からカメラが適
正露出を判断しシャッターやゲインを⾃動的に調整します。 
詳細 →ユーザーガイド

 NARROW 画⾯中央の約 10%を範囲とします。
MIDDLE 画⾯中央の約 40%を範囲とします。
FULL 画⾯全体を範囲とします。
CIRCLE 画⾯中央円形部分を範囲とします。
USER 任意部分を範囲とします。

Peak Ratio [Shutter][Gain][Iris Control]が AUTO 時、この値の配分から被写体の明
るさを測定する⽅法（測光⽅式）を調整します。 
詳細 →ユーザーガイド

Auto 
Brightness 

 明るさ調整の⾃動制御、シャッタースピード、ゲイン、絞りの個別設定がで
きます。

ON 機能オン
  Brightness Level AUTO 時の明るさのレベル 

Shutter Control シャッター制御 
“値”を上げ過ぎるとちらつきが発⽣することがありま
す。 
”LED 照明や蛍光灯”などの放電灯証明のもとでは、フ
リッカが⼤きくなる場合があります。 

AUTO オート制御 
Shutter Limit シャッタースピードの上限
Slow Shutter スローシャッターの有効/無効
Slow Shutter Limit スローシャッター時のシャッ

タースピード下限

Brightness 
 
Quit 
Response MIDDLE 

Photometry ENTER ⇒ 

Auto Brightness ON ⇒ 

Hyper Gain OFF 
High Sensitivity OFF 
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MANUAL マニュアル制御 
Shutter Speed シャッタースピード

Gain ゲイン値
AUTO オート制御 
Base ゲイン⾃動制御の下限 

Limit ゲイン⾃動制御の上限
MANUAL マニュアル制御 
Normal Gain マニュアル制御時のゲイン設

定値 
Iris Control(※) 絞り制御

AUTO オート制御 
Iris Priority 減光制御の優先度を絞りかシ

ャッターかを選択 

MANUAL マニュアル制御 
Iris Level 値を⼤きくすると絞りが開く、

⼩さくすると絞りが閉じる。 

OFF 機能オフ
  Shutter Speed シャッタースピードを設定します。 

Normal Gain ゲイン値を設定します。
Iris Level 絞りレベルを設定します。 

Hyper Gain  ゲインの最⼤値を広げ⾼感度で撮影するモードにします。 
 OFF 機能オフ

ON 機能オン
High 
Sensitivity 

  画素加算を⾏ないカメラの感度をアップします。 

 OFF 機能オフ
 PIXEL MIX OFF よりも感度は 2 倍向上。横⽅向の解像度が劣化します。 
 LINE MIX OFF よりも感度は 2 倍向上。縦⽅向の解像度が劣化します。 
 P/L MIX OFF よりも感度は 4 倍向上。縦⽅向、横⽅向ともに解像度が劣化します。

 
※Iris Control の設定は【Others】の[CCU Type]がʼSLITʼの場合は表⽰されません。 
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【Brightness】ユーザーガイド 
 
[トップ]→[PICTURE]→[Brightness] 

 
次のページに進むと各設定が⾏なえます。 

 
 
 
 

■ご使⽤にあたり 
 
Auto Brightness  ON の下の階層メニューの設定を 
 
Shutter Control  AUTO 
Gain   AUTO 
Iris Control  AUTO※ 
 
にして下さい。 
 
※注意 
Iris Control はカメラからアイリスを制御できる顕
微鏡アダプタを使⽤する場合にのみ、AUTO 機能が
動作します。 
カメラからのアイリス制御⾮対応の顕微鏡アダプ
タを使⽤する場合、MANUAL に設定してください。
CCU TYPE が SLIT の場合、表⽰されません。

 
注意 
[Shutter Control][Gain][Iris Control]のうち最低
１つが AUTO でないとこの機能は動作しません。

 

 
 
 
 
 
 
 
 
 
 

PICTURE 
Brightness 
Contrast 
Color 
Sharpness 
Scene File 

FUNCTION 
Function 
Foot Switch 
Function Key 

SYSTEM 
Video Format 
Date/Time 
Others 
Information 

Brightness 
 
Quit 
Response MIDDLE 

Photometry ENTER ⇒ 

Auto Brightness        ON ⇒ 

Hyper Gain OFF 
High Sensitivity OFF 

Brightness→Auto Brightness 

 
Quit 
Brightness Level 0 
Shutter Control AUTO 
Gain AUTO 
Iris Control AUTO 
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【Brightness】ユーザーガイド 
 
Response 
被写体の変化に対応できる明るさ⾃動調整機能の反
応速度をここで設定できます。 
[Response]→[MIDDLE]に合わせ、▲,▼ボタンを押
して設定を変更する。 

 
メモ 
この機能は Photometry にて設定した測光エリアの
設定を組み合わせることでより⾼い効果が期待でき
ます。 
 
Photometry 
測光するエリアと測光⽅式を設定します。 
[Photometry]→[ENTER]に合わせる。 

 
次のページに進むと各設定が⾏なえます。 

 
 
 
 
 

Measurement Area 
⾃動調整の判定で使⽤する測光エリアを選択できま
す。 
設定した範囲の光量からカメラが絞りやシャッター
スピードを調整し露出を⾃動制御します。 
またこの設定は AWB 制御の測光エリアとしても機能
します。 
 
MIDDLE 

 
NARROW 

 
CIRCLE 

 
USER(初期設定画⾯) 

 
  

Brightness 
 
Quit 
Response MIDDLE 
Photometry ENTER 

Auto Brightness        ON ⇒ 

Hyper Gain OFF 
High Sensitivity OFF 

Brightness → Photometry 

 
Quit 
Measurement Area MIDDLE 
Peak Ratio 12 
 

Brightness 
 
Quit 

Response ⇕MIDDLE 

Photometry ENTER ⇒ 

Auto Brightness        ON ⇒ 

Hyper Gain OFF 
High Sensitivity OFF 
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【Brightness】ユーザーガイド 
 
■測光枠のマニュアル設定 
測定枠は任意の範囲に設定できます。測光枠を調整す
ると、使⽤環境に応じて映像の⾃動調整が可能になり
ます。 
 
■セッティング 
[Brightness]→[Photometry] → [Measurement 
Area]→[USER]を選択し、決定ボタンを押します。 
 
測光枠のマニュアル設定画⾯が表⽰されます。 
決定ボタンを押すと、 
[Position]→[Top&Left]→[Bottom&Right]の順に変
化します。 

 
設定完了後、測光枠の位置と⼤きさを調整できます。
[Bottom&Right]で決定ボタンを押すと測光枠のマニ
ュアル設定を終了します。 
 
■Position 設定 
Position を選択すると、測光枠の位置を調整できま
す。 
 

▲/▶/▼/◀ボタンで位置を調整します。 
 
 
 
 

■Size 設定 
[Top&Left]または[Bottom&Right]を選択すると、
測光枠の⼤きさを調整できます。 

 
▲/▶/▼/◀ボタンで位置を調整します。 
[Top&Left]︓測光枠の左辺と上辺の⼤きさを調整しま
す。 
「▲」「◀」ボタンで拡⼤します。  
「▼」「▶」ボタンで縮⼩します。 
 
 
Peak Ratio  
カメラが被写体の明るさを測定する⽅法（測光⽅式）
の配分をこの値により調整します。 
被写体と背景の状況に応じた設定に調整することで
適正な露出にすることができます。 
 
最⼤(63)でピーク測光、最⼩(0)でアベレージ測光に
なります。 
 
■ピーク 
測光エリア内の明るい被写体に応じて⾃動調整を⾏
う。 
 
■アベレージ 
⼀部の明るい被写体に依らず、測光エリア全体の被写
体に応じて⾃動調整を⾏う。 
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【Brightness】ユーザーガイド 
 
Auto Brightness 
映像の明るさの⾃動調節に関連する設定を⾏います。 
 
[Auto Brightness]→[ON]に合わせる。 

 
次のページに進むと各設定が⾏なえます。 
 
[ON]の次ページ 

 
[OFF]の次ページ 

 
Auto Brightness の ON/OFF は前⾯パネルの明るさ
⾃動ボタンと連動します。 
（ON のとき明るさ⾃動ボタンが点灯） 
 

Brightness Level 
⾃動制御時の明るさレベルの調整ができます。 
ここで設定したレベルを基準に、シャッタースピード、
ゲイン、絞りを制御して適切な明るさに調整されます。
映像が暗すぎる際にはレベルを上げ、明るすぎる際に
はレベルを下げることで映像が⾒やすくなります。 
 
明るさ補正ツマミとの併⽤ 
前⾯パネルの明るさ補正ツマミで追加調整すること
ができます。 
 

 
Shutter Control 
電⼦シャッターに関する設定が⾏なえます。 
制御は「Auto」と「Manual」から選択します。 
 
Auto の場合、スローシャッターの有効/無効、スロー
シャッタースピードの下限、の設定もここで⾏なえま
す。 

 
メモ 
Auto 時、蛍光照明下などでフリッカ（ちらつき）が発
⽣する場合は、Shutter Limit の設定を「1/125」や
「1/100」にする、絞りを調整する、などで現象を抑
えられます。 
 
 
 
 
 
 
  

Brightness 
 
Quit 
Response MIDDLE 

Photometry ENTER⇒ 

Auto Brightness       ⇕ON ⇒ 

Hyper Gain OFF 
High Sensitivity OFF 

Brightness → Auto Brightness 

 
Quit 
Brightness Level     0 
Shutter Control AUTO 
Gain AUTO 
Iris Control AUTO 
 

Brightness → Auto Brightness 

 
Quit 
Shutter Speed OFF 
Normal Gain -12dB 
Iris Level 0 
 

Brightness → Shutter Control 

 
Quit 
Shutter Limit 1/4000 
Slow Shutter DISABLE 
Slow Shutter Limit 1/15 
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【Brightness】ユーザーガイド 
 
High Sensitivity 
被写体への光量が少なく光量を増やすことができな
い環境で撮影する際に役⽴ちます。 
 
[High Sensitivity]→[OFF]に合わせる。 

 
設定を変更します。 

 
■PIXEL MIX  
感度は 2 倍向上しますが横⽅向の解像度が劣化しま
す。 
 
■LINE MIX 
感度は 2 倍向上しますが縦⽅向の解像度が劣化しま
す。 
 
■P/L MIX  
感度は 4 倍向上しますが縦⽅向、横⽅向ともに解像度
が劣化します。 
 

Brightness 
 
Quit 
Response MIDDLE 

Photometry ENTER ⇒ 

Auto Brightness        ON ⇒ 

Hyper Gain OFF 

High Sensitivity ⇕OFF 

Brightness 
 
Quit 
Response MIDDLE 

Photometry ENTER ⇒ 

Auto Brightness        ON ⇒ 

Hyper Gain OFF 

High Sensitivity ⇕PIXEL MIX 
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Contrast               
⿊や⽩のレベル、階調などを調節する項⽬です。 

 
 

Item Setting value Description
Pedestal  ⿊のレベルを調整します。 

値を⼤きくするほど映像全体が明るくなります。 
Flare  フレアの補正値を設定します。 

値を⼤きくするほど暗部の⽩浮きを抑制します。 
Gamma   ガンマ補正を使⽤し明暗差を調整します。 

詳細 → ユーザーガイド
 OFF 機能オフ
 SDR 標準的なダイナミックレンジで表現するモード 
  Level ガンマ補正の補正カーブを調整します。 
 HDR 広ダイナミックレンジで表現するモード 

HDR 機能のないモニターを使⽤すると、画像が暗くなる場合があります。
  HLG1-3 詳細→ユーザーメニュー

Knee   ⼆―機能。被写体の⾼輝度部分をカメラのダイナミックレンジ内におさめ、
⽩つぶれを改善することができます。 
詳細 → ユーザーガイド

 OFF 機能オフ
 ON 機能オン

White 
Shading 

  光学系による⾊むらを補正します。
 ON 機能オン
 AUTO ⾃動測定します。
 Initialize 設定をリセットします。
 OFF 機能オフ

Black 
STR/PRS 

  暗部の階調を調整します。 
詳細→ユーザーガイド

 OFF 機能オフ
 ON 機能オン
 Slope ⿊の階調が変えられます。

 
  

Contrast 
 
Quit 
Pedestal 0 
Flare 7 

Gamma         SDR ⇒ 

Knee ON ⇒ 

White Shading OFF 
Black STR/PRS OFF 
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【Contrast】ユーザーガイド 
 
[トップ]→[PICTURE]→[Contrast] 

 
次のページに進むと各設定が⾏なえます。 
 
 
 
 
 
 

Gamma 
ガンマ補正の設定が⾏えます。 
 
[Gamma]→[SDR]に合わせる。 

 
[OFF][SDR][HDR]いずれかに設定します。 
（詳細は P31 をご参照ください。） 
[SDR]または[HDR]の場合、次のページに進むと各設
定が⾏なえます。 
 
[SDR] 

 
[HDR] 

 
  

PICTURE 
Brightness 
Contrast 
Color 
Sharpness 
Scene File 

FUNCTION 
Function 
Foot Switch 
Function Key 

SYSTEM 
Video Format 
Date/Time 
Others 
Information 

Level 
0

Contrast → Gamma 

 
Quit 

Level ⇕0 
 

Contrast 
 
Quit 
Pedestal 0 
Flare 7 

Gamma SDR⇒ 

Knee ON ⇒ 

White Shading OFF 
Black STR/PRS OFF 

Contrast 
 
Quit 
Pedestal 0 
Flare 7 

Gamma ⇕SDR⇒ 

Knee ON ⇒ 

White Shading OFF 
Black STR/PRS OFF 

Contrast → Gamma 

 
Quit 

Mode ⇕HLG2 
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【Contrast】ユーザーガイド 
 
SDR (Standard Dynamic Range) 
⼀般的なビデオモニターに最適な階調で表現しま
す。ITU-R 勧告 BT.709 相当のガンマ補正が適⽤さ
れます。 
 
■LEVEL 
ガンマ補正による明暗の階調表現のレベルが調節で
きます。 
値を⼩さくするほど明度は上がり、値を⼤きくするほ
ど明度は下がります。 
 
メモ 
ビデオモニターのガンマ特性と揃えると適切な階
調表現になります。 
 
HDR (High Dynamic Range) 
暗い部分から明るい部分までの階調をより⾃然で被
写体そのものに近い⾊合いで表現できます。 
 
■HLG1-3 
HLG1 HLG(Hybrid Log-Gamma)対応モニタ

ーでの映像表現に最適化した設定です。
基準の⽩を撮影した時、約 50%のレベ
ルとしてビデオ出⼒されます。 

HLG2 HLG1 と HLG3 のバランスを考慮した設
定です。基準の⽩を撮影した時、約 70%
のレベルとしてビデオ出⼒されます。

HLG3 HLG の⾃然な映像表現を HLG ⾮対応の
モニターで表現するための設定です。基
準の⽩を撮影した時、約 90%のレベル
としてビデオ出⼒されます。 

 
 
メモ 
HDR は[Image Priority]の設定を [D-RANGE](ダイ
ナミックレンジ優先)に設定しているときのみ使⽤で
きます。（P61） 
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【Contrast】ユーザーガイド 
 
Knee 
Knee の設定を⾏えます。 
 
[Knee]→[ON]に合わせる。 

 
次のページに進むと各設定が⾏なえます。 

 
Mode 
Knee の制御モードを選べます。 
 
■AUTO 
映像レベルから Knee ポイント・Knee スロープを⾃
動的に設定します。 
 
メモ 
⾼光量が⼊射した際、本機が Knee ポイント・Knee ス
ロープの最適値を判断し、設定している Point/Slope
からさらに⾃動圧縮を⾏ないます。 
 
■MANUAL 
映像レベルによらず Knee ポイント・Knee スロープ
は設定している値で固定します。 
 
Point 
Knee ポイントの値を調節できます。 

Slope 
Knee スロープの値を調整できます。 
+⽅向にするほど下図の傾斜が緩やかになります。 
結果、圧縮率が⾼まりより⾼いレベルの信号までダイ
ナミックレンジ内に収まるようになります。 
 

 
White Shading 
照明やレンズなどの光学系の⾊、明るさむらを補正す
る機能です。 
実⾏時の撮影環境に応じて補正量を⾃動で計算する
AUTO White Shading 機能を備えています。 
 
シェーディングがある画像例 

ホワイトシェーディング補正した画像例 

 

 

  

Contrast 
 
Quit 
Pedestal 0 
Flare 7 

Gamma         SDR ⇒ 

Knee ⇕ON ⇒ 

White Shading OFF 
Black STR/PRS OFF 

Contrast → Knee 

 
Quit 
Mode AUTO 
Point -56 
Slope 50 
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■AUTO White Shading の実⾏ 
1. 撮影条件下で⽩紙など凹凸の少ない⽩い被写体

を画⾯全体に映します。 
 

2. [White Shading]の次のページに進み、[AUTO]
を選択し選択肢[START]に切り替えます。 

 

 
3. [START]を選択し、決定ボタンを押すと補正デー

タの計算を開始します。画⾯下に[Busy]メッセー
ジが表⽰されます。Busy 表⽰中はカメラや被写
体を動かさないでください。 
 

4. 補正データの計算が完了すると[Completed]メ
ッセージが表⽰され映像に補正がかかります。 

 
注意 
AUTO を実⾏すると補正データ取得と同時に AWB
が実⾏されます。 
White Balance で MANUAL や ATW を使⽤する場
合は、AUTO 実⾏後に設定を⾏ってください。

 
[メッセージ⼀覧] 
・ Busy 

ホワイトシェーディング補正データを取得中 
・ Completed 

ホワイトシェーディング補正データの取得が完
了 

・ Error 
補正データが取得できませんでした。 
明るさを調整し再度 AUTO White Shading を実
⾏してください。 

■Initialize の実⾏ 
AUTO White Shading の補正データを初期化します。 
 
1. [White Shading] の 次 の ペ ー ジ に 進 み 、

[Initialize]を選択し選択肢[START]に切り替え
ます。 
 

 
2. [START]を選択し、決定ボタンを押すと補正デー

タを出荷状態に初期化します。 
 
 
Black STR/PRS 
暗部のコントラストを調整できます。 
設定値を+⽅向にするほど暗部が伸⻑され、-⽅向にす
るほど圧縮されます。 
 
[Black STR/PRS]→[OFF]に合わせる。 

 
[ON]にすると機能が有効になります。 
 
次のページに進むと Slope の設定が⾏えます。 

 
Slope 
暗部の映像を伸⻑、圧縮し階調を補正します。 
 
 

Contrast 
 
Quit 
Pedestal 0 
Flare 7 

Gamma         SDR ⇒ 

Knee ON ⇒ 

White Shading OFF 

Black STR/PRS ⇕OFF 

Contrast → Black STR/PRS 

 
Quit 

Slope ⇕0 
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Color                
⾊彩や⾊の濃さを調整する項⽬です。 
⾊調整は前⾯パネルの⾊補正ツマミ(⾚)、⾊補正ツマミ(⻘)と併⽤することができます。 

 
 
 

Item Setting value Description 
Red Level  ⾚⾊の濃さを調整します。 

詳細 →ユーザーガイド
Blue Level  ⻘⾊の濃さを調整します。 

詳細 →ユーザーガイド
White Balance   ホワイトバランスの動作モードを設定します。 

AWB 実⾏時の撮影環境に合わせて、⾃動的にホワイトバランスを調節しま
す。 

ATW 被写体の⾊温度変化に対しホワイトバランスを⾃動追従して調整し
ます。

MANUAL ⾚のゲインと⻘のゲインをマニュアルで制御します。 
Chroma Level  ⾊の彩度を調整します。
Low Light Chroma  映像の暗い部分の彩度を調整します。
Matrix   カラーマトリックスの値を設定します。 

詳細 →ユーザーガイド
 OFF 機能オフ
 ON 機能オン

Color Correct   カラーコレクションの値を設定します。 
詳細 →ユーザーガイド

 OFF 設定オフ
 ON 設定オン

Color 
 
Quit 
Red Level 0 
Blue Level 0 

White Balance   AWB ⇒ 

Chroma Level 0  
Low Light Chroma 0 
Matrix OFF 
Color Correct OFF 
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【Color】ユーザーガイド 
 
[トップ]→[PICTURE]→[Color] 

 
次のページに進むと各設定が⾏なえます。 

 
 
 
 
 
 
 
 
 
 
 
 

Red Level 
⾚⾊の濃さが設定できます。 
 
[Red Level]→数値に合わせる。 

映像内の⾚⾊の濃さが+⽅向にするほど濃く、－⽅
向にするほど薄くなります。 
 
Blue Level 
⻘⾊の濃さが設定できます。 
 
[Blue Level]→数値に合わせる。 

映像内の⻘⾊の濃さが+⽅向にするほど濃く、-⽅向
にするほど薄くなります。 
 
メモ 
ホワイトバランスを調整した画に対しての⾊味調整
を⾊補正ツマミや Red/Blue Level から⾏ないます。 

 
メニュー設定で⾏う Red/Blue Level 設定と前⾯パ
ネルの⾚/⻘のツマミによる⾊補正は同じ効果です。
どちらの場合もホワイトバランスを調節した後の映
像に対して⾊味の補正を⾏います。 
したがって、メニューの設定数値やツマミが中点に
無い場合は、AWB でホワイトバランスの調節後、⾊
味が設定されている補正状態となります。

Color 
 
Quit 

Red Level ⇕0 
Blue Level 0 

White Balance   AWB ⇒ 

Chroma Level 0  
Low Light Chroma 0 
Matrix OFF 
Color Correct OFF 

PICTURE 
Brightness 
Contrast 
Color 
Sharpness 
Scene File 

FUNCTION 
Function 
Foot Switch 
Function Key 

SYSTEM 
Video Format 
Date/Time 
Others 
Information 

Color 
 
Quit 
Red Level 0 

Blue Level ⇕0 

White Balance   AWB ⇒ 

Chroma Level 0  
Low Light Chroma 0 
Matrix OFF 
Color Correct OFF 

Color 
 
Quit 
Red Level 0 
Blue Level 0 

White Balance   AWB ⇒ 

Chroma Level 0  
Low Light Chroma 0 
Matrix OFF 
Color Correct OFF 
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【Color】ユーザーガイド 
 
White Balance 
[White Balance]→[AWB]に合わせる。 

 
設定を変更します。 

 
 
AWB（通常はこちらを選択してください） 
実⾏時の撮影環境（照明）の⾊味に応じて⾃動的に
ホワイトバランスのレベルを調整します。 
・初回撮影時 
・撮影環境を変えた時 
などで実⾏してください。 
 
ATW 
照明や環境光の⾊味に応じて動的にホワイトバラン
スを調整します。 
・照明などの撮影環境によらず⾊味を⼀定に保ちた

い場合に設定してください。 
 
MANUAL 
ホワイトバランスを⼿動で調整します。 
 

■AWB の実⾏ 
1. ⽩い被写体を画⾯全体に映す。 
2. [AWB]の次ページに進み、[AUTO]を READY か

ら START にし、決定ボタンを押す。 
 

 

 
3. 状態に応じてメッセージが表⽰されます。 
 
AWB Busy 
実⾏中 
 
AWB Completed 
完了 
 
AWB LEVEL OVER 
AWB LEVEL UNDER 
AWB NOT WHITE 
AWB OUT OF RANGE 
AWB ERROR 
異常を検出 
処理が正常に完了していません。 
 
エラー/警告表⽰ 
オートホワイトバランスに関するエラーメッセージ
（P86）をご確認の上条件を変えて再度実⾏して下
さい。 
 
 
 
 
 
 
 
 
 
  

Color → White Balance 

 
Quit 

AUTO ⇕READY 
 

Color → White Balance 

 
Quit 

AUTO ⇕START 
 

Color 
 
Quit 
Red Level 0 
Blue Level 0 

White Balance   ⇕AWB⇒ 

Chroma Level 0  
Low Light Chroma 0 
Matrix OFF 
Color Correct OFF 

Color 
 
Quit 
Red Level 0 
Blue Level 0 

White Balance   ⇕ATW  
Chroma Level 0  
Low Light Chroma 0 
Matrix OFF 
Color Correct OFF 
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【Color】ユーザーガイド 
 
[Matrix]および[Color correct]の設定における各ア
ルファベットは次の⾊を表します。 
 
R︓⾚ G︓緑 B︓⻘ 
Mg︓マゼンタ Cy︓シアン Ye︓⻩ 
 
メモ 
ほぼすべての⾊は⾚、緑、⻘、マゼンタ、シアン、⻩、
から表現することができます。 
[Matrix]および[Color correct]ではそれをイメージ
するのに次の図を⽤います。また各設定を動かした
際に⾊合いがどのように変化するかを同じ図にて⽰
します。 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Matrix 
各軸の設定を変更するとグレースケールの⾊味・明
るさが⼀定になるように全ての⾊の表現が連動して
動きます。 
 
[Matrix]→[OFF]に合わせる。 

 
[ON]に切り替え、次のページに進む。 

 
各設定を変更します。 

 
 
  

Color 
 
Quit 
Red Level 0 
Blue Level 0 

White Balance   AWB⇒ 

Chroma Level 0  
Low Light Chroma 0 

Matrix ⇕ON⇒ 

Color Correct OFF 

Color → Matrix 

 
Quit 
R-G 0 
R-B 0 
G-R 0 
G-B 0 
B-R 0 
B-G 0 

Color 
 
Quit 
Red Level 0 
Blue Level 0 

White Balance   AWB⇒ 

Chroma Level 0  
Low Light Chroma 0 

Matrix ⇕OFF 
Color Correct OFF 
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【Color】ユーザーガイド 
 
各軸の値を＋⽅向、－⽅向に変更した際、⾊は次の⽅向に変化します。 
※基準線(各図における太線)上の⾊は変わりません。 
 

（R-G） (R-B)

 
 

（G-R） （G-B） 

 
（B-R） （B-G） 
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【Color】ユーザーガイド 
 
Color Correct 
彩度や⾊相の詳細な調整ができます。 
 
[Color Correct]→[OFF]に合わせる。  

 
[Color Correct]→[ON]に切り替え、次のページに進
む。 

 
各設定を変更します。 

 
 

 
 
本機は１６に分割した⾊に対してそれぞれの彩度・
⾊相を独⽴して調整することができます。 
 
設定内のʻ⾊ No.̓は次の図の各軸に対応します。 
 

 
 
 
  

Color 
 
Quit 
Red Level 0 
Blue Level 0 

White Balance   AWB⇒ 

Chroma Level 0  
Low Light Chroma 0 
Matrix OFF 

Color Correct ⇕OFF 

Color 
 
Quit 
Red Level 0 
Blue Level 0 

White Balance   AWB⇒ 

Chroma Level 0  
Low Light Chroma 0 
Matrix OFF 

Color Correct ON⇒ 

Color → Color Correct 

 
Quit 
Page 1/2 
 
Mg1 Gain 0 
Mg1 Phase 0 
Mg2 Gain 0 
Mg2 Phase 0 
Mg3 Gain 0 
Mg3 Phase 0 
R1 Gain 0 
R1 Phase 0 
R2 Gain 0 
R2 Phase 0 
R3 Gain 0 
R3 Phase 0 
Ye1 Gain 0 
Ye1 Phase 0 
Ye2 Gain 0 
Ye2 Phase 0 
 

Color → Color Correct 

 
Quit 
Page 2/2 
 
G1 Gain 0 
G1 Phase 0 
G2 Gain 0 
G2 Phase 0 
G3 Gain 0 
G3 Phase 0 
Cy1 Gain 0 
Cy1 Phase 0 
Cy2 Gain 0 
Cy2 Phase 0 
Cy3 Gain 0 
Cy3 Phase 0 
B1 Gain 0 
B1 Phase 0 
B2 Gain 0 
B2 Phase 0 
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【Color】ユーザーガイド 
 
ʻGainʼは選択した⾊の彩度を調整します。 
 
＋⽅向にすると彩度が上がり、－⽅向にすると彩度
が下がります。 

 
 
ʻPhaseʼは選択した⾊を類似⾊に変化させます。 
 
メモ 
基準の⾊に対し隣⽅向に位置する⾊が類似⾊に該当
します。 

 
＋⽅向にするほど左回り、－⽅向にするほど右回り
の⽅向の⾊にシフトしていきます。 

 
メモ 
特定の⾊のみ調整したい場合、⾚、緑、⻘、マゼン
タ、シアン、⻩、から変更元の⾊に最も近いものを選
び、その⾊の Phase 設定のみ変更下さい。 
 

R2 の場合 

 
ʻR2 Gainʼ を＋⽅向にするほど、R2 軸上の⾊のレベ
ルが上がり、鮮やかさが増します。 

 
ʻR2 Gainʼ を-⽅向にするほど、R2 軸上の⾊のレベ
ルが下がり、鮮やかさが下がります。 

 
ʻR2 Phaseʼ を＋⽅向にしていくほど、⻩寄りの⾊に
変化します。 

 
ʻR2 Phaseʼ を-⽅向としていくほど、マゼンタ寄り
の⾊に変化します。 
 



41 
 

Sharpness               

輪郭を強調する機能です。 
 

 
 
 
Item Setting value Description
Sharpness  輪郭強調機能の ON/OFF を選択します。

 OFF 機能オフ
ON 機能オン

Level  輪郭強調の度合いを調整します。Sharpness は ON にして下さい。
Boost Freq.  輪郭強調する周波数を設定します。 

詳細 →ユーザーガイド
Mode  輪郭の濃さの度合いを設定します。

 SOFT 標準 
HARD 強 

 
 
 
 
 
 
 
 
 
 
 
 
 

Sharpness 
 
Quit 
Sharpness ON 
Level 2 
Boost Freq.   16MHz 
Mode HARD 
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【Sharpness】ユーザーガイド 
 
輪郭補正に関する設定が⾏えます。 
[トップ]→[PICTURE]→[Sharpness] 

 
次のページに進むと各設定が⾏なえます。 

 
注意 
本機能は[Sharpness]が ON の場合に有効です。
OFF は同画⾯中の Level , Boost Freq. , Mode の
設定は無効になっています。

 
 
 
 
 
 
 
 
 
 
 
 

Level 
輪郭の強調度合を調整します。値を⼤きくするほど
輪郭がはっきりします。 
 
Boost Freq. 
輪郭にエッジをかけ強調させる周波数を設定します。 
 
[Boost Freq.]→設定に合わせ、エッジを効かせたい
周波数に最も近いものを選びます。 

 
ぼけている部分は周波数が低いので Boost Freq.は
低くするとエッジが⽴ちやすくなります。 
 
Mode 
輪郭の濃さを「SOFT」、「HARD」から選択します。
輪郭を濃くしたい場合は「HARD」にして下さい。
「HARD」の描写が強すぎる場合は「SOFT」にする
ことで描写をソフトにすることができます。 
 
メモ 
被写体の輪郭にジャギー(階段状のギザギザ)が⾒え
ることがありますが故障ではありません。気になる
場合は、「Level」を下げる、「Boost Freq.」を上げ
る、「Mode」を SOFT にする、などして画質を調整
して下さい。 
 
 

PICTURE 
Brightness 
Contrast 
Color 
Sharpness 
Scene File 

FUNCTION 
Function 
Foot Switch 
Function Key 

SYSTEM 
Video Format 
Date/Time 
Others 
Information 

Sharpness 
 
Quit 
Sharpness ON 
Level 2 
Boost Freq. �16MHz 
Mode HARD 
 

Sharpness 
 
Quit 
Sharpness �ON 
Level 2 
Boost Freq.   16MHz 
Mode HARD 
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Scene File               

調整した設定情報はシーンファイルとして保存、必要に応じて呼び出すことが可能です。 
シーンファイルは▲▼◀▶ボタンに保存することができ、最⼤で４つ保存できます。 
 

 
 
 
 
 

Item Description
Load 設定されたシーンファイルを選択し、読み出します。
Save 設定した状態をシーンファイルに保存します。設定したいシーンファイルを選択し、決定ボ

タンを押すと実⾏されます。
Initialize シーンファイルの設定値を⼯場出荷時の状態に初期化します。 

初期化したいシーンファイルを選択し、決定ボタンを押すと実⾏されます。 
 
  
 

Scene File 
 
Quit 
Load No.1 
Save READY 
Initialize   READY  
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【Scene File】ユーザーガイド 
 
シーンファイル選択 
シーンファイル No は１〜４があります。 
メニュー画⾯と CCU 前⾯のシーンファイルボタン
(▲▼◀▶ボタンと共⽤)の 2 通りで呼び出すことが
できます。 
 
 
⽅法 1︓メニュー画⾯で呼び出す場合 
 
[トップ]→[PICTURE]→[Scene File] 

 
[Load]の番号を変更すると該当するシーンファイ
ルが呼び出されます。 
 
 
⽅法 2︓CCU 前⾯から呼び出す場合 
 
メニュー画⾯を閉じた状態で CCU 前⾯のシーンフ
ァイルボタン(▲▼◀▶ボタンと共⽤)を押すとシー
ンファイルが呼び出されます。 
 

 
現在の画⾯は▲▼◀▶の点灯しているボタンのシー
ンファイルの情報が適⽤されています。 
 

 
シーンファイルの保存 
現在の画⾯の設定情報を選択したシーンファイルに
記録します。 
 
注意 
現在の画⾯の設定情報がシーンファイルに保存さ
れます。 
予め保存したい設定にしてから実⾏して下さい。

 
■保存⽅法 
設定の保存⽅法は下記の 2 通りあります。 

 
⽅法１︓設定後、メニューを⼀度閉じる。 
⽅法 2︓Scene File 画⾯の Save を保存先のファイ
ル No.に切り替え、決定ボタンを押す。 

 
 
シーンファイルの初期化 
シーンファイルの情報を初期化します。 
 
Initialize を READY から対象ファイル No.に 
切り替え、決定ボタンを押す。 

 
設定のリセットが⾏なわれ、選択したシーンファイ
ルの設定が⼯場出荷時の状態になります。 
 
 
 

Scene File 
 
Quit 
Load No.1 
Save READY 
Initialize   READY  
 

Scene File 
 
Quit 
Load No.1 
Save No.2 
Initialize   READY  
 

Scene File 
 
Quit 
Load No.1 
Save READY 
Initialize   No.2  
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FUNCTION 
Function               

拡⼤縮⼩、映像の反転、ノイズリダクション、センサーのホットピクセル補正、コントラストを調整する項⽬で
す。 

 
Item Setting value Description 

Magnifier  デジタルズームの倍率を設定します。
Flip  映像を反転させます。 

 OFF 機能オフ
H FLIP 映像を左右に反転します。
V FLIP 映像を上下に反転します。
ROTATE 映像を上下左右に反転します。

DNR  ノイズ低減機能の設定
 OFF 機能オフ

ON 機能オン
2D-DNR Level 空間⽅向のノイズ低減機能 
T-DNR Level 時間⽅向のノイズ低減機能 

Real Time DPC  センサーのホットピクセルを⾃動的に補正し⽬⽴たなくします。 
詳細 →ユーザーガイド

Adv.Sharpness 
(オプション) 

 輪郭付近の⾊コントラストを強調しテクスチャの視認性を向上させ
る機能 
詳細→ユーザーガイド

Picture Effect 
(オプション) 

 被写体の画に特殊処理を施し視認性を向上させる機能 
 OFF 機能オフ

CONTRAST 暗部、明部のコントラストを強調し視認性を向上させる機能
BLOOD ⽑細⾎管等の細かいテクスチャを強調表⽰する機能 
DEFOG 煙やモヤによって⽩浮きしコントラストが低い映像に対して視認性

を改善する機能
Fluorescence  蛍光撮影時の励起光⾊を抑え、蛍光部の視認性を向上させる機能

 OFF 機能オフ
FLUORESCEIN フルオレセインモードにします。詳細→ユーザーガイド

Red Level ⾚の濃さを調整します。 
Blue Level ⻘の濃さを調整します。 
Green Phase 蛍光⾊の⾊味を調整できます。 

Chroma Level 彩度を調整します。
 
※オプション機能を使⽤するにはライセンス（別売）が必要です。ライセンスされていない CCU ではオプショ
ン機能は表⽰されません。 

Function 
 
Quit 

Magnifier ×1.0 
Flip OFF 

DNR   ON ⇒ 

Real Time DPC ON 
Adv.Sharpness OFF 
Picture Effect OFF 
Fluorescence OFF 
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【Function】ユーザーガイド 
 
[トップ]→[FUNCTION]→[Function] 

 
次のページに進むと各設定が⾏なえます。 

 
 
 
 
 
 

Real Time DPC 
Real Time DPC は、⾼温環境、HIGH ゲイン、スロ
ーシャッターの撮影時に出現するホットピクセルを
⾃動的に補間し⽬⽴たなくします。 
 
⼯場出荷後まれに映像内にホットピクセルと呼ばれ
る画素⽋陥が映ることがあります。 
イメージセンサー特有の現象であり、故障ではあり
ません。 
 
センサーの特性上、⼯場出荷時の標準的なホットピ
クセル補正で除去しきれない極めて⼩さいサイズを
内包することがあります。また宇宙線など影響を受
けると新たに⽣じることもあります。 
 
次の状況で⾒えやすくなります。 
・ HIGH ゲイン設定 
・ スローシャッター 
・ ⾼温環境 
 

 

 
 
メモ 
プリズム内のごみやカメラヘッドの内側に付いた汚
れに対してはこの機能は働きません。 
 
 
 
  

PICTURE 
Brightness 
Contrast 
Color 
Sharpness 
Scene File 

FUNCTION 
Function 
Foot Switch 
Function Key 

SYSTEM 
Video Format 
Date/Time 
Others 
Information 

 

 

Real Time DPC
ON 

Real Time DPC
OFF 

Function 
 

Quit 

Magnifier x1.0 

Flip OFF 

DNR   ON⇒ 

Real Time DPC ON 

Adv.Sharpness OFF 

Picture Effect OFF 

Fluorescence OFF 
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【Function】ユーザーガイド 
 
DNR 
映像ノイズを低減する機能です。 
 
2D-DNR 
1 フレームの映像内でノイズ成分を平滑し、映像ノ
イズを低減します。 
 
メモ 
かけすぎると解像度が劣化することがあります。 
 
T-DNR 
複数フレームにわたりノイズ成分を平滑し、映像ノ
イズを低減します。 
 
メモ 
かけすぎると残像が残りやすくなります。 
 
 
 
 
 

Fluorescence 
蛍光された被写体を捉えるのに適した⾊と画質のモ
ードに切り替えます。 
 
FLUORESCEIN 
映像処理にて⻘光源⾊を抑え、蛍光部との⾊コント
ラストを⾼めた映像を出⼒するフルオレセインモー
ドにします。 
 
[Fluorescence]→[OFF]に合わせる。  

 
[FLUORESCEIN]に切り替え、次のページに進む。 

 
各設定が変更できます。 

  

Function→Fluorescence 

 

Quit 

Red Level 0 

Blue Level 0 

Green Phase 0 

Chroma Level 50 

 

Function 
 

Quit 

Magnifier x1.0 

Flip OFF 

DNR   ON⇒ 

Real Time DPC ON 

Adv.Sharpness OFF 

Picture Effect OFF 

Fluorescence ⇕ FLUORESCEIN⇒ 

 

Function 
 

Quit 

Magnifier x1.0 

Flip OFF 

DNR   ON⇒ 

Real Time DPC ON 

Adv.Sharpness OFF 

Picture Effect OFF 

Fluorescence ⇕OFF 
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【Function】ユーザーガイド 
 
メモ 
イエローフィルタ等の光学フィルタを併⽤する場合
は通常モード（機能オフ）でご使⽤ください。 
 
■⾊味や⾊相を調整する 
・ Red Level 

フルオレセインモード時の映像の⾚⾊の濃さを
調整できます。 

 
・ Blue Level 

フルオレセインモード時の映像の⻘⾊の濃さを
調整できます。 

 
・ Green Phase 

蛍光⾊の⾊味を調整できます。 
 
・ Chroma Level 

フルオレセインモード時の映像の⾊相が調整で
きます。 

 
注意 
フルオレセインモードの映像は通常モードとは別
の⾊設定になります。フルオレセインモードにおけ
る⾚、⻘、⾊相、は本項の機能より設定下さい。 
また、フルオレセインモードの映像に対してホワイ
トバランスの調整は⾏えません。 
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Ex.Function 機能 
Ex.Function 機能はオプションライセンス（有償）が必要です。 
 
【Ex.Function 機能】ユーザーガイド 
 
Adv.Sharpness 
明瞭度が上がりテクスチャの視認性が向上します。明るい部分と暗い部分の階調を損なわずに輪郭をくっきりさ
せることができます。 
 
[Adv.Sharpness]→[ON]に切り替える。      次のページで輪郭強調のレベルを調整できます。 

 
 
[PICTURE]の[Sharpness]は明暗差がもともと存在している部分に効果がかかります。背景のぼけなどにはあま
り影響を与えずに調節できます。かけすぎるとノイズが⽬⽴つようになります。 

補正前 [PICTURE]の[Sharpness]で補正後
  

 
 
Adv.Sharpness は[PICTURE]の[Sharpness]よりもノイズを抑えてエッジが強調できます。かけすぎると誇張
的な描写になります。 

補正前 Adv.Sharpness で補正後 
  

 
メモ 
[PICTURE]の[Sharpness]と Adv.Sharpness は併⽤可能です。[PICTURE]の[Sharpness]で⼀定まで輪郭の強
調をかけたのち Adv.Sharpness で追加調整を⾏なうという使い⽅もできます。 
 

Function 
 

Quit 

Magnifier x1.0 

Flip OFF 

DNR   ON⇒ 

Real Time DPC ON 

Adv.Sharpness ⇕ON⇒ 

Picture Effect OFF 

Fluorescence OFF 
 

Function→Adv.Sharpness 

 
Quit 
Level 0 
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Ex.Function 機能 
Ex.Function 機能はオプションライセンス（有償）が必要です。 
 
【Ex.Function 機能】ユーザーガイド 
 
Picture Effect 
本機は医療現場で撮影する際に役⽴つ機能を複数搭載しています。 
 
Contrast 
[PICTURE]の[Contrast]は撮影環境に応じて調整するのに向いた機能ですが、撮影環境がほぼ変わらず効果の強
弱だけで⼗分な場合はこちらをお使い頂くと簡単にコントラストが調整できます。 
 
 
[Picture Effect]→[CONTRAST]に切り替える。      次のページでコントラストの強さが設定できます。 

 
 
 
 

Function 
 

Quit 

Magnifier x1.0 

Flip OFF 

DNR   ON⇒ 

Real Time DPC ON 

Adv.Sharpness OFF 

Picture Effect ⇕CONTRAST⇒ 

Fluorescence OFF 
 

Function→CONTRAST 

 
Quit 
Mode MIDDLE 
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Ex.Function 機能 
Ex.Function 機能はオプションライセンス（有償）が必要です。 
 
【Ex.Function 機能】ユーザーガイド 
 
BLOOD 
⾎管や粘膜表層の状態を強調表⽰する機能です。 
 
[Picture Effect]→[BLOOD]に切り替える。   次のページで補正のレベルが設定できます。 

 
 
⾚と明暗差の⼤きな部分とのコントラストを上げ、⽑細⾎管などの細部の視認性が向上します。 

元の映像 BLOOD で補正後 
  

 
 
 
 

Function 
 

Quit 

Magnifier x1.0 

Flip OFF 

DNR   ON⇒ 

Real Time DPC ON 

Adv.Sharpness OFF 

Picture Effect ⇕BLOOD⇒ 

Fluorescence OFF 
 

Function→BLOOD 

 
Quit 
Mode MIDDLE 
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Ex.Function 機能 
Ex.Function 機能はオプションライセンス（有償）が必要です。 
 
【Ex.Function 機能】ユーザーガイド 
 
DEFOG 
煙や霧など被写体が霞んでしまっているときに役⽴つ機能です。 
 
[Picture Effect]→[DEFOG]に切り替える。   次のページで補正のレベルが設定できます。 

 
 
低下しているコントラストが改善され、霞んでいた映像の透明感が増します。 

元の映像 DEFOG で補正後 
  

 

Function 
 

Quit 

Magnifier x1.0 

Flip OFF 

DNR   ON⇒ 

Real Time DPC ON 

Adv.Sharpness OFF 

Picture Effect ⇕DEFOG⇒ 

Fluorescence OFF 
 

Function→DEFOG 

 
Quit 
Mode MIDDLE 
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Foot Switch               

フットスイッチに割り当てる機能を設定します。 
 

 
 

Item Setting value Description
Switch1-4  外付けスイッチを押したときに働く機能の設定をします。 

最⼤４つのスイッチに機能を割り当てることができます。 
 NONE 機能なし

FREEZE 映像を静⽌画にします。再度押すと解除されます。 
SCENE 
F(ROT) 

押すたびにシーンファイルを１→２→３→4→1・・・の順にローテーシ
ョンしながら変えていきます。

H FLIP 映像を左右反転します。
V FLIP 映像を上下反転します。
ROTATE 映像を上下左右に反転します。
ZOOM IN ×1.0〜×4.0 (0.1 刻み)の範囲で押すたびに⼀段階ずつズームインしま

す。 
ZOOM OUT ×1.0〜×4.0 (0.1 刻み)の範囲で押すたびに⼀段階ずつズームアウトし

ます。
FLUORESCEIN フルオレセインモードに切り替えます。
AWB オートホワイトバランスを実⾏します。
SCENE1 画⾯をシーンファイル１の映像にします。
SCENE2 画⾯をシーンファイル２の映像にします。
SCENE3 画⾯をシーンファイル３の映像にします。
SCENE4 画⾯をシーンファイル４の映像にします。
SCENE1<->2 シーンファイル１と２を交互に切り替えます。 
SCENE1<->3 シーンファイル１と 3 を交互に切り替えます。 
SCENE1<->4 シーンファイル１と 4 を交互に切り替えます。 
SCENE2<->3 シーンファイル 2 と 3 を交互に切り替えます。 
SCENE2<->4 シーンファイル 2 と 4 を交互に切り替えます。 
SCENE3<->4 シーンファイル 3 と 4 を交互に切り替えます。 

 
 

Foot Switch 
 
Quit 
Switch1 NONE 
Switch2 NONE 
Switch3   NONE 
Switch4 NONE 
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Function Key               

ファンクションボタンに割り当てる機能を設定します。 
 

 
 

Item Setting value Description
Key1 
Key2 

  ファンクションボタンが押されたときどの機能になるかを設定します。
 NONE 機能無し

H FLIP 映像を左右反転します。
V FLIP 映像を上下反転します。
ROTATE 映像を上下左右に反転します。
ZOOM IN 0.1 倍単位で⼀段階ずつ拡⼤倍率を上げます。 
ZOOM OUT 0.1 倍単位で⼀段階ずつ拡⼤倍率を下げます。 
FLUORESCEIN フルオレセインモードに切り替えます。 

FREEZE 映像を静⽌画にします。
 
【Foot Switch / Function Key】ユーザーガイド 
 
FREEZE 
フットスイッチまたはファンクションボタンに
「FREEZE」を設定している場合、1 回押すとカメラ
の映像が静⽌画で出⼒されます。 
 
静⽌中は CCU 前⾯の画⾯静⽌ランプが点灯します。 
 

 
再度押すと静⽌が解除されて元に戻ります。 
また画⾯静⽌ランプが消灯します。 

 
メモ 
・ 静⽌中はメニュー内の設定を操作することは出

来ますが、映像には反映されません。静⽌を解
除するとそれまでの変更が反映された映像に変
わります。 
 

・ 静⽌機能はフットスイッチとファンクションボ
タンで同⼀です。両⽅に FREEZE を設定してい
る場合、フットスイッチの操作で静⽌にしたも
のをファンクションボタンの操作で解除するこ
と、またはその逆も可能です。 

 
 
 
 
 
 
 
 

Function Key 
 
Quit 
Key1 NONE 
Key2 NONE 
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SYSTEM 
Video Format               

映像出⼒のフォーマットを設定します。 
 
 

 
 
 
 

Item Setting value Description
Frame Rate  出⼒信号のフレームレートを設定します。 

この設定は全ての出⼒⽅式で共有されます。 
 59.94Hz 59.94Hz 設定

50Hz 50Hz 設定
SDI Output  SDI の出⼒信号のフォーマットを設定します。 

 1080p プログレッシブ⽅式
1080i インターレース⽅式

HDMI Output   HDMI の出⼒フォーマットを設定します。 
詳細→ユーザーガイド

AUTO 接続された HDMI モニターで表⽰可能なフォーマットで⾃動設定します。
2K 次の中から接続された HDMI モニターで表⽰可能なフォーマットのみ選

択肢に表⽰されます。
1920×1080p YCbCr444 12bit 1920×1080p YCbCr 4:4:4 12bit で

出⼒します。 

1920×1080p YCbCr444 10bit 1920×1080p YCbCr 4:4:4 10bit で
出⼒します。 

1920×1080p RGB444  12bit 1920×1080p RGB 4:4:4 12bit で出
⼒します。 

1920×1080p RGB444  10bit 1920×1080p RGB 4:4:4 10bit で出
⼒します。 

1920×1080p YCbCr422 10bit 1920×1080p YCbCr 4:2:2 10bit で
出⼒します。 

1920×1080p RGB444   8bit 1920×1080p RGB 4:4:4 8bit で出⼒
します。 

1920×1080i YCbCr422 10bit 1920×1080i YCbCr 4:2:2 10bit で出
⼒します。 

1920×1080i RGB444   8bit 1920×1080i RGB 4:4:4 8bit で出⼒
します。 

Video Format 
 
Quit 

Frame Rate 59.94Hz 
SDI Output 1080p 
HDMI Output   AUTO 
HDMI Mode NORMAL 
Color Gamut BT.709 
H Position 0 
V Position 0 
Genkock OFF 
3D Support OFF 
Center Marker OFF 
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HDMI Mode   HDMI 端⼦からの映像出⼒形式を設定します。 
詳細→ユーザーガイド

NORMAL HDMI 形式で HDMI Output で設定された映像を出⼒します。
DVI DVI 形式で映像を出⼒します。 1920×1080p RGB 4:4:4 8bit で

出⼒します。 
Color Gamut   出⼒映像の⾊域を設定します。

 BT.709 ITU-R 勧告 BT.709 に準拠した⾊域の映像信号を出⼒します。
 BT.2020 ITU-R 勧告 BT.2020 に準拠した⾊域の映像信号を出⼒します。

H Position   表⽰位置を１画素単位で横に移動します。 
+1 ごとに 1 ピクセル右に、-1 ごとに 1 ピクセル左に、移動します。

V Position  表⽰位置を１画素単位で縦に移動します。 
+1 ごとに 1 ピクセル上に、-1 ごとに 1 ピクセル下に、移動します。

Genlock  ゲンロックの設定を⾏ないます。
 OFF 機能オフ
 AUTO Genlock コネクタに同期信号が⼊⼒されると、⾃動的に外部同期に切り替

わります。
 H Phase 出⼒映像信号の⽔平位相を調整します。
 V Phase 出⼒映像信号の垂直位相を調整します。

3D Support 
(→P71 参照) 

 2 台のカメラを使い３D 撮影する際に設定します。 
 OFF 機能オフ

ON 機能オン
Center Marker  画⾯中央にセンターマーカーを表⽰します。 

 OFF 表⽰オフ
ON 表⽰オン
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【Video Format】ユーザーガイド 
 
[トップ]→[SYSTEM]→[Video Format] 

 
次のページに進むと各設定が⾏なえます。 

 
 
 

HDMI Output 
本機の HDMI 出⼒は様々なフォーマットに対応して
います。本機は設定を AUTO にすることで出⼒先の
HDMI モニターに対応したフォーマットに⾃動設定
される機能を有します。また、接続した HDMI モニ
ターが対応しているフォーマットを選択肢から選ぶ
ことができます。 
 
■フォーマットの変更⽅法 
[HDMI Output]→[AUTO]に合わせ、設定を[2K]に
変える。 

 
次のページに進む。 
[Format]→現在の設定にカーソルを合わせ、変更し
たい先の⽅式に変える。 

 

  

Video Format 
 
Quit 
Frame Rate 59.94Hz 
SDI Output 1080p 
HDMI Output   AUTO 
HDMI Mode NORMAL 
Color Gamut BT.709 
H Position 0  
V Position 0 
Genlock OFF 
3D Support OFF 
Center Marker OFF 

Video Format 
 
Quit 
Frame Rate 59.94Hz 
SDI Output 1080p 

HDMI Output   ⇕2K⇒ 

HDMI Mode NORMAL 
Color Gamut BT.709 
H Position 0  
V Position 0 
Genlock OFF 
3D Support OFF 
Center Marker OFF 

Video Format → HDMI Output(2K) 

 
Quit 

Format ⇕1080p RGB444 8bit 
    
 

PICTURE 
Brightness 
Contrast 
Color 
Sharpness 
Scene File 

FUNCTION 
Function 
Foot Switch 
Function Key 

SYSTEM 
Video Format 
Date/Time 
Others 
Information 
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【Video Format】ユーザーガイド 
 
HDMI Mode 
本機の HDMI 出⼒を変換ケーブルなど使⽤して DVI
⼊⼒の機器に接続する際には以下の設定をすること
を推奨します。 
設定を DVI にするとモニターによらず「RGB 4:4:4 
8bit」で映像出⼒されます。 
 
■設定の変更⽅法 
[HDMI Mode]→[NORMAL]に合わせ、設定を[DVI]
に変える。 

 
メニュー画⾯を閉じて設定を保存する。 
再起動すると下図のように設定が変更されています。 

 
メモ 
HDMI Mode を DVI に変更後は HDMI Output を変
更しないでください。映像が乱れる場合があります。 
再起動すると必ず「RGB 4:4:4 8bit」で映像出⼒さ
れます。 
 

Video Format 
 
Quit 
Frame Rate 59.94Hz 
SDI Output 1080p 
HDMI Output   AUTO 
HDMI Mode DVI 
Color Gamut BT.709 
H Position 0  
V Position 0 
Genlock OFF 
3D Support OFF 
Center Marker OFF 

Video Format 
 
Quit 
Frame Rate 59.94Hz 
SDI Output 1080p 

HDMI Output   ⇕2K⇒ 

HDMI Mode DVI 
Color Gamut BT.709 
H Position 0  
V Position 0 
Genlock OFF 
3D Support OFF 
Center Marker OFF 
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Date/Time                                                 

本機に内蔵されている時計機能の時刻設定が⾏なえます。 
設定データの更新⽇時と時刻を合わせるのに必要になります。 
 

 
 
 
 

Item Description
Year 

各時刻情報を設定します。 
Month 
Day 
Hours 
Minutes 

 
 
 

Date/Time 
 
Quit 
Year 2023 
Month 3 
Day 2 
Hours 11 
Minutes 34 
Seconds 20 
Setting READY 
 
             2023-03-02 
               11:34:20 
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【Date/Time】ユーザーガイド 
 
[トップ]→[SYSTEM]→[Date/Time] 

 
次のページに進むと各設定が⾏なえます。 

 
 
 
 
 
 
 
 
 

■設定⽅法 
合わせたい項⽬にカーソルを合わせます。 

 
値を変更します。 

 
年⽉⽇時分秒全ての設定が完了したら Setting を
SET に変え、決定ボタンを押す。 

 
正常に完了すると COMPLETED が表⽰されます。 

 
以上で時刻合わせは完了です。 
 

Date/Time  
 
Quit 
Year 2023 
Month * 
Day   * 
Hours * 
Minutes *  
Seconds * 

Setting ⇕SET 
 

Date/Time  
 
Quit 
Year 2023 
Month * 
Day   * 
Hours * 
Minutes *  
Seconds * 
Setting COMPLETED 

Date/Time  
 
Quit 
Year **** 
Month * 
Day   * 
Hours * 
Minutes *  
Seconds * 
Setting READY 
 

PICTURE 
Brightness 
Contrast 
Color 
Sharpness 
Scene File 

FUNCTION 
Function 
Foot Switch 
Function Key 

SYSTEM 
Video Format 
Date/Time 
Others 
Information 

Date/Time  
 
Quit 

Year ⇕**** 
Month * 
Day   * 
Hours * 
Minutes *  
Seconds * 
Setting READY 
 

Date/Time  
 
Quit 

Year ⇕2023 
Month * 
Day   * 
Hours * 
Minutes *  
Seconds * 
Setting READY 
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Others                

設定のリセット、USB メモリーを⽤いた設定データの保存/読み込み、カメラケーブルの延⻑設定、に関する項
⽬です。 
 

 
Item Setting value Description

Initialize   シーンファイル以外のすべての設定を⼯場出荷時の状態にリセットしま
す。 
詳細→ユーザーガイド

USB Memory 
 

  USB メモリーを介した設定の保存・読み込み 
 NO MEDIA USB メモリーの接続が認識できません。 

※この表⽰が出ている間以下の３つは⾮表⽰になっています。
 READY USB メモリーを使う準備が整いました。 

※この表⽰の後に▲▼ボタンを押すと以下の２つが選択のみになりま
す。 

 CCU→USB 設定データを USB メモリーに保存します。 
詳細→ユーザーガイド

 USB→CCU USB メモリーにある本機の設定データを読み込みます。 
詳細→ユーザーガイド

CCU Type 
 

  設定を⼿術顕微鏡向け/スリットランプ向けのものにします。 

 MICRO ⼿術顕微鏡向け 

 SLIT スリットランプ向け 

Language  メニュー内の⾔語を選択できます。 

 ENGLISH 英語 
中⽂ 中国語 

Cable Length   カメラケーブルの⻑さに応じて設定します。 
SHORT カメラケーブル 3m〜7ｍを使⽤の場合は SHORT にして下さい。
LONG 延⻑⽤カメラケーブルを使⽤する場合は LONG にして下さい。

Image Priority  出⼒映像を[ダイナミックレンジ]優先するか、[ノイズ低減]優先するか
を設定します。

 D-RANGE 出⼒映像のダイナミックレンジを優先する。 
S/N 出⼒映像のノイズ低減を優先する。

LED 
Brightness 

 CCU 前⾯パネルの LED の明るさを変更できます。 

Others 
 
Quit 
Initialize  READY 
USB Memory READY 
CCU Type MICRO 
Language ENGLISH 
Cable Length   SHORT 
Image Priority D-RANGE 
LED Brightness LOW 
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【Others】ユーザーガイド 
 
Initialize 
設定を⼯場出荷時の状態にリセットする機能です。 
 
[Initialize]→READY にカーソルを合わせる。 

 
READY を START に変える。 

 
決定ボタンを押す。 
 
数秒後、選択肢が COMPLETED に変わります。 

 
メモ 
START 実⾏後のキャンセルはできません。USB 
Memory の CCU→USB を活⽤しあらかじめバック
アップをしておくことを推奨します。 

 
 
USB Memory 
USB Memory の選択肢が NO MEDIA となっている
ことを確認後、USB メモリーを USB ポートに差し
て下さい。 

 

 
USB Memory の選択肢が NO MEDIA から READY
に切り替わったことをご確認下さい。 

 
注意 
READY に切り替わらない場合は何かの要因で
USB メモリーを認識できていません。トラブルシ
ューティングを参考にご対応下さい。解決しない場
合は営業担当にご相談下さい。 

  

Others  
 
Quit 

Initialize     ⇕READY 
USB Memory READY 
CCU Type MICRO 
Language ENGLISH 
Cable Length   SHORT 
Image Priority D-RANGE 
LED Brightness LOW 
  

Others  
 
Quit 

Initialize    ⇕START 
USB Memory READY 
CCU Type MICRO 
Language ENGLISH 
Cable Length   SHORT 
Image Priority D-RANGE 
LED Brightness LOW 

 

Others  
 
Quit 

Initialize    ⇕COMPLETED 
USB Memory READY 
CCU Type MICRO 
Language ENGLISH 
Cable Length   SHORT 
Image Priority D-RANGE 
LED Brightness LOW 
 

 

Others  
 
Quit 
Initialize    READY 

USB Memory ⇕NO MEDIA 
CCU Type MICRO 
Language ENGLISH 
Cable Length   SHORT 
Image Priority D-RANGE 
LED Brightness LOW 
 

Others  
 
Quit 
Initialize      READY 

USB Memory ⇕READY 
CCU Type MICRO 
Language ENGLISH 
Cable Length   SHORT 
Image Priority D-RANGE 
LED Brightness LOW 
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【Others】ユーザーガイド 
 
CCU→USB  
本機の設定データを USB メモリーに保存する機能
です。 
 
(1)▲▼ボタンで選択肢を CCU→USB に変える。 

 
(2)決定ボタンを押し実⾏します。 

画⾯に USB Memory Busy が表⽰されます。 

 
(3)しばらくして USB Memory Completed が画⾯
に表⽰されれば完了です。 

 
完了後、USB メモリーのルートディレクトリに設定
データファイル“SETTING.MSF”が保存されます。 
 

 
 
USB→CCU 
本機の設定データが USB メモリーに存在する場合、
その設定値を本機に反映します。 
 
(1)▲▼ボタンで選択肢を USB→CCU に変える。 

 
(2)決定ボタンを押し実⾏します。 

画⾯に USB Memory Busy が表⽰されます。 

 
(3)しばらくして USB Memory Completed が画⾯
に表⽰されれば完了です。 

 
 
 
  

Others  
 
Quit 
Initialize      READY 

USB Memory ⇕CCU→USB 

CCU Type MICRO 
Language ENGLISH 
Cable Length   SHORT 
Image Priority D-RANGE 
LED Brightness LOW 
 

USB Memory Completed 

Others  
 
Quit 
Initialize      READY 

USB Memory ⇕CCU→USB 

CCU Type MICRO 
Language ENGLISH 
Cable Length   SHORT 
Image Priority D-RANGE 
LED Brightness LOW 
 

 

Others  
 
Quit 
Initialize      READY 

USB Memory ⇕USB→CCU 

CCU Type MICRO 
Language ENGLISH 
Cable Length   SHORT 
Image Priority D-RANGE 
LED Brightness LOW 

 

Others  
 
Quit 
Initialize      READY 

USB Memory ⇕USB→CCU 

CCU Type MICRO 
Language ENGLISH 
Cable Length   SHORT 
Image Priority D-RANGE 
LED Brightness LOW 
 

USB Memory Completed 

Others  
 
Quit 
Initialize      READY 

USB Memory ⇕CCU→USB 

CCU Type MICRO 
Language ENGLISH 
Cable Length   SHORT 
Image Priority D-RANGE 
LED Brightness LOW 

 
 

USB Memory Busy 

Others  
 
Quit 
Initialize      READY 

USB Memory ⇕USB→CCU 

CCU Type MICRO 
Language ENGLISH 
Cable Length   SHORT 
Image Priority D-RANGE 
LED Brightness LOW 
 

 
USB Memory Busy 
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【Others】ユーザーガイド 
 
CCU Type 
設定値を⼿術顕微鏡向け(MICRO)/スリットランプ
向け(SLIT)にします。 
 
(1)CCU Type→[MICRO]にカーソルを合わせる。 
 

 
(2)▲▼ボタンでメッセージが表⽰します。 

[YES]を選択し決定ボタンを押すと切り替わり
ます。 

 
 
 
 

■ご使⽤にあたり 
[Iris Control](【Brightness】→[Auto Brightness]
→ON)の項⽬は選択先によって画⾯⾃体が変わりま
す。 
 
MICRO 

 
SLIT 

 
 
 
 
 
 
 
 
  

Others  
 
Quit 
Initialize      READY 

USB Memory CCU→USB 

CCU Type ⇕MICRO 
Language ENGLISH 
Cable Length   SHORT 
Image Priority D-RANGE 
LED Brightness LOW 

 

Others  
 
Quit 
Initialize      READY 

USB Memory CCU→USB 

CCU Type ⇕MICRO 
Language ENGLISH 
Cable Length   SHORT 
Image Priority D-RANGE 
LED Brightness LOW 

 

Change CCU Type︖ 

Yes   No 

Brightness→Auto Brightness 

 
Quit 
Brightness Level 0 
Shutter Control AUTO 
Gain AUTO 
Iris Control AUTO 

Brightness→Auto Brightness 

 
Quit 
Brightness Level 0 
Shutter Control AUTO 
Gain AUTO 
 

ʻSLITʼ選択中は表⽰されません 
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【Others】ユーザーガイド 
 
Cable Length 
カメラケーブルを延⻑した場合は設定を LONG に設
定してください。 
 

 
 

 
 
注意 
カメラケーブルの⻑さに適さない設定にしている
と映像が映らない、乱れるなどの症状が起こります
が故障ではありません。 
ご不明点は営業担当にご相談下さい。 

 
 
 
 
 
 
 
 

SHORT カメラケーブル 1 本(3,5,7m)で使⽤す
る場合 

LONG 延⻑⽤カメラケーブルを使⽤する場合

Others  
 
Quit 
Initialize      READY 

USB Memory CCU→USB 

CCU Type MICRO 
Language ENGLISH 

Cable Length   ⇕LONG 
Image Priority D-RANGE 
LED Brightness LOW 
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Information                                                    

本機にインストールされているファームウェアのバージョン情報です。 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Information  
 
CCU Firmware V*.***-**** 
CCU FPGA  V*.***-**** 
Head FPGA V*.** 
 
 
Serial No. ******** 
Option ***** 
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システム使⽤例 
フットスイッチを使う 

フットスイッチを本機に接続します。 
 

 
[FUNCTION]→[Foot Switch]で設定画⾯を開く。 

 
フットスイッチに設けられているスイッチ番号と
Switch の 1〜4 が対応します。 
 
以下は S1＝Switch1  S2=Switch2 の例です。 
 
 
 
 
 
 
 
 
 

スイッチに割り当てる機能を設定します。 
（P53） 
 
・ NONE 
・ FREEZE 
・ SCENEF(ROT) 
・ H FLIP 
・ V FLIP 
・ ROTATE 
・ ZOOM IN 
・ ZOOM OUT 
・ FLUORESCEIN 
・ AWB 
・ SCENE 1 
・ SCENE 2 
・ SCENE 3 
・ SCENE 4 
・ SCENE 1 ↔ 2 
・ SCENE 1 ↔ 3 
・ SCENE 1 ↔ 4 
・ SCENE 2 ↔ 3 
・ SCENE 2 ↔ 4 
・ SCENE 3 ↔ 4 
 
 
 
 

Foot Switch 
 
Quit 
Switch1  NONE 
Switch2  NONE 
Switch3  NONE 
Switch4  NONE 

S1 
⿊ 

S2 
緑 



68 
 

リモート制御する

CCU と外部制御機器を RS-232C ケーブルでつなぐ
ことでリモート制御が可能です。 
 

 
・ 本機の RS-232C 端⼦は D-SUB 9 ピンオスで

す。またシールド付き品をご使⽤下さい。 
・ 通信コマンド仕様の詳細は営業担当にお問い合

わせ下さい。 
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スリットランプアダプタを使う 

STEP1 
カメラヘッドをスリットランプアダプタに取り付け
る。 
 
 
 
 
 
 
 
 
 
STEP2 
カメラケーブルをカメラヘッドに接続します。 
このときコネクタの向きにご注意下さい。 
 
 
 
 
 
 
 
 
 
 
STEP3 
スリットランプアダプタを取り付ける。 
 
 
 
 
 
 
 
 
 
 
 
 
STEP4 
CCU にカメラケーブルを接続する。 
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STEP5 
ビデオ出⼒ケーブルを出⼒先に接続する。 
 
 
 
 
 
 
 
 
 
 
 
STEP6 
付属の電源ケーブルを CCU に接続します。 
最後にコンセントとつなげて電源をオンにします。 
 
 
 
 
 
 
 
 
 
 
 
 
STEP7 
カメラで⽩い被写体を撮影した状態で CCU 前⾯の
ホワイトバランスボタンを押し、ホワイトバランス
を調整します。 
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2 台のカメラを使い３D 撮影をする 
外部同期 
 
3D システムを使⽤する場合は 2 台のカメラ映像信
号の同期が必要です。 
 
映像信号を同期させるにはCCU背⾯の⼀⽅のSYNC
出⼒端⼦と他⽅の GENLOCK ⼊⼒端⼦を 75Ω 同軸
ケーブルで接続します。 
 
 
メモ 
SYNC 端⼦の出⼒条件︓ 
3 値 SYNC 0.6Vp-p/75Ω 
 
カメラ内部で⾮同期モードから外部同期モードに⾃
動的に切り替わります。 
 
配線例 
本機を２セット 
(プライマリ×1/セカンダリ×1)⽤意します。 
CCU（プライマリ）の SYNC コネクタと CCU（セカ
ンダリ）の GENLOCK コネクタを同軸ケーブルで接
続します。 
 
 

■セッティング 
 
3D で使⽤する場合、プライマリ CCU、セカンダリ
CCU 、 2 台 の [Video Format]→[Genlock]→[H 
Phase]/[V Phase]の値を揃えること。 
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3D サポート機能 
 
本機には 3D サポート機能があります。 
プライマリの SYNC とセカンダリの GENLOCK を同
軸ケーブルで接続します。また、RS-232C ケーブル
で接続することで 2 台の CCU を同期することがで
きます。 
左右ユニットの各種カメラ機能の設定を同期させ、
3D システム構築時に簡単に調整できます。 
 
 
■接続と設定 
本機の 3D システムは、プライマリ機 1 台、セカ
ンダリ機 1 台、および 3D 対応モニターで構成さ
れます。 
下図のように各機器を接続します。 
 
■セッティング 
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プライマリとセカンダリの設定 
 
1. プライマリ CCU の SYNC コネクタとセカンダ

リ CCU の GENLOCK コネクタを同軸ケーブル
で接続する。 
 

2. 2 台の CCU の RS-232C 端⼦同⼠を RS-232C
クロスケーブルで接続する。 

注意 
RS-232Cクロスケーブルは両端がD-SUB9ピンメ
ス品をご使⽤下さい。 

 
3. 2 台の CCU を 3D 対応モニターと接続する。 

※出⼒は両機とも3D対応モニターに接続する。 
※左右カメラの出⼒接続はモニターの仕様をご
確認下さい。 

 
4. CCU を起動する（どちらの CCU からでも可）。 

 
5. [SYSTEM]→[Video Format]→[Genlock]の設

定を AUTO に変更する。 

 
6. [SYSTEM]→[Video Format]→[3D Support]

の設定を ON に変更する。 

 
 
 
 

 
7. 次ページに進み、プライマリにする⽅の CCU の

設定を PRIMARY、セカンダリにする⽅の CCU
の設定を SECONDARY、に変更する。 

 

 
前⾯パネルとメニューの連携 
設定が完了すると、[ホワイトバランス]、[オートシ
ャッター]、[明るさ⾃動]、[オートアイリス]、[各ボ
リュームの設定値]などがプライマリとセカンダリ
間で連動し、プライマリ CCU の設定がセカンダリ
CCU に⾃動反映されます。 
 
 
 

Video Format→3D Support 

 
Quit 

Mode ⇕SECONDARY 
 

Video Format 
 
Quit 
Frame Rate 59.94Hz 
SDI Output 1080p 
HDMI Output   AUTO 
HDMI Mode NORMAL 
Color Gamut BT.709 
H Position 0  
V Position 0 
Genlock AUTO 
3D Support OFF 
Center Marker OFF 

Video Format 
 
Quit 
Frame Rate 59.94Hz 
SDI Output 1080p 
HDMI Output   AUTO 
HDMI Mode NORMAL 
Color Gamut BT.709 
H Position 0  
V Position 0 
Genlock AUTO 
3D Support ON 
Center Marker OFF 

Video Format→3D Support 

 
Quit 

Mode ⇕PRIMARY 
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仕様 
 
製品構成 
 
カメラヘッド 
 
カメラコントロールユニット(CCU) 
 
カメラケーブル (5m) 
 
電源ケーブル 
 
フェライトコア (型名︓E04SR200935A) 
 
取扱説明書(本書) 
 
⼀般 
 
電源 
AC 100 – 240V ±10%（50/60Hz） 
0.5A – 0.2A 
 
動作温度 
0℃ – +40℃ 
(湿度 90%以下で結露なきこと) 
 
相対湿度 
30% to 90% (⾮結露) 
 
輸送/保管温度 
-20℃ to +70℃ 
(湿度 90%以下で結露なきこと) 
 
輸送/保管時の湿度 
0% to 90% (⾮結露) 
 
輸送/保管時の気圧 
700hPa to 1060hPa 
 
外形⼨法 
カメラヘッド 

W34mm×H40mm×D40mm 
CCU 

W210mm×H58mm×D270mm 
 
質量 
カメラヘッド   100g 以下 
カメラコントロールユニット 2kg 以下 
 

カメラヘッド 
 
撮像素⼦ 
1/2.8 インチ CMOS センサー×３ 
 
有効画素数 
1920×1080 画素 
 
⽔平解像度 
1000TV 本 
 
感度 
F13(2000lx/3200K) 
 
S/N 
63dB 
 
使⽤できるレンズ 
・C マウント 
・レンズマウント⾯からの⾶び出し量 

4.1mm 以下のもの 
 
CCU 
 
出⼒端⼦/フォーマット 
3G/HD-SDI（2 系統） 

59.94/50Hz 
1920×1080p 
1920×1080i 

HDMI (１系統) 
59.94/50Hz 
1920×1080p YCbCr  4:4:4 12bit
1920×1080p YCbCr  4:4:4 10bit
1920×1080p RGB    4:4:4 12bit
1920×1080p RGB    4:4:4 10bit
1920×1080p YCbCr  4:2:2 10bit
1920×1080p RGB    4:4:4 8bit
1920×1080i YCbCr  4:2:2 10bit
1920×1080i RGB    4:4:4 8bit

 
⼊出⼒端⼦ 
CAMERA 

丸型２０ピン 
RS-232C (1 系統) 

D-SUB 9 ピン（オス） 
FOOT SW (1 系統) 

D-SUB 9 ピン（メス） 
GENLOCK IN (１系統) 
SYNC OUT(１系統) 
 
その他  
 
  等電位端⼦ 
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カメラヘッド外観 
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CCU 外観 
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設定情報 
※1︓Initialize で初期化されない項⽬です。 
※2︓Others -> Image Priority の設定に依存します。 
 
Brightness 

Item Initial Value Setting Range 
Scene File 1 Scene File 2 Scene File 3 Scene File 4

Response MIDDLE FAST, MIDDLE, SLOW
Photometry ENTER ENTER
 Measurement Area MIDDLE NARROW, MIDDLE, FULL, USER, CIRCLE 

Peak Ratio 26 26 12 12 0〜63
Auto Brightness ON OFF, ON
ON  
 Brightness Level 15 15 0 0 -128〜127

Shutter Control AUTO AUTO, MANUAL
AUTO  
Shutter Limit 1/10000 1/100, 1/125, 1/250, 1/500, 1/1000, 1/2000, 

1/4000, 1/5000, 1/6400, 1/8000, 1/10000 
Slow Shutter DISABLE DISABLE, ENABLE
ENABLE 
Slow Shutter Limit 

 
50Hz: 1/12 
59.94Hz: 1/15 

 
50Hz 
: 1/3, 1/6, 1/12, 1/25 
59.94Hz 
: 1/4, 1/8, 1/15, 1/30

MANUAL  
Shutter Speed OFF 50Hz 

:1/3, 1/6, 1/12, 1/25, OFF, 1/100, 1/125, 
1/250, 1/500, 1/1000, 1/2000, 1/4000, 
1/5000, 1/6400, 1/8000, 1/10000 

59.94Hz 
:1/4, 1/8, 1/15, 1/30, OFF, 1/100, 1/125,  
1/250, 1/500, 1/1000, 1/2000, 1/4000, 
1/5000, 1/6400, 1/8000, 1/10000
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Gain AUTO AUTO, MANUAL
AUTO  
Base 
※2︓Image Priority=D-RANGE 

-12dB -12dB,-9dB,-6dB,-3dB,0dB,3dB 

Base 
※2︓Image Priority=S/N 

-18dB -18dB,-15dB,-12dB,-9dB,-6dB,-3dB 

Limit 
※2︓Image Priority=D-RANGE 

12dB 12dB 9dB 9dB -9dB〜21dB(3dB 刻み) 

Limit 
※2︓Image Priority=S/N 

6dB 6dB 3dB 3dB -15dB〜15dB(3dB 刻み) 

MANUAL  
Normal Gain 
※2︓Image Priority=D-RANGE 

0dB -12dB〜21dB (1dB 刻み) 

Normal Gain 
※2︓Image Priority=S/N 

-6dB -18dB〜15dB (1dB 刻み) 

Iris Control AUTO AUTO, MANUAL
AUTO 

Iris Priority
 
IRIS 

 
IRIS, SHUTTER

MANUAL 
Iris Level

 
0 

 
-128〜127

OFF  
 Shutter Speed OFF 50Hz 

:1/3, 1/6, 1/12, 1/25, OFF, 1/100, 1/125,  
1/250, 1/500, 1/1000, 1/2000, 1/4000, 
1/5000, 1/6400, 1/8000, 1/10000 

59.94Hz 
:1/4, 1/8, 1/15, 1/30, OFF, 1/100, 1/125,  
1/250, 1/500, 1/1000, 1/2000, 1/4000, 
1/5000, 1/6400, 1/8000, 1/10000

Normal Gain 0dB 
※2︓Image Priority=D-RANGE

-12dB〜21dB (1dB 刻み) 

-6dB 
※2︓Image Priority=S/N

-18dB〜15dB (1dB 刻み) 

Iris Level 0 -128〜127
Hyper Gain OFF OFF,ON
High Sensitivity OFF OFF, PIXEL MIX, LINE MIX, P/L MIX
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Contrast 

Item Initial Value Setting Range 
Scene File 1 Scene File 2 Scene File 3 Scene File 4

Pedestal 0 -64〜64
Flare 7 0〜50
Gamma SDR OFF, SDR, HDR

SDR 
Level 

 
-26 

 
-26

 
0

 
0 

 
-128〜127

HDR 
Mode 

 
HLG3 

 
HLG1, HLG2, HLG3

Knee ON OFF, ON
ON  

Mode AUTO AUTO, MANUAL
AUTO  
Point -77 -128〜127
Slope 26 -128〜127
MANUAL  
Point -44 -128〜127
Slope 64 -128〜127

White Shading OFF OFF, ON
ON  

 AUTO READY READY, START
Initialize READY READY, START

Black STR/PRS OFF OFF, ON
ON 

Slope 
 
0 

 
-20〜20
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Color 

Item Initial Value Setting Range 
Scene File 1 Scene File 2 Scene File 3 Scene File 4

Red Level 35 28 0 0 -256〜255
Blue Level -80 -65 0 0 -256〜255
White Balance AWB AWB, ATW, MANUAL

AWB READY READY, START
ATW - -
MANUAL  

Red Level 0 -128〜383
Blue Level 0 -128〜383

Chroma Level 0 -128〜127
Low Light Chroma 0 -32〜32
Matrix OFF OFF, ON
ON  

R-G 0 -170〜342
R-B 0 -170〜342
G-R 0 -170〜342
G-B 0 -170〜342
B-R 0 -170〜342
B-G 0 -170〜342

Color Correct OFF OFF, ON
ON  Page 1/2  
 Mg1 Gain 0 -64〜63

Mg1 Phase 0 -32〜31
Mg2 Gain 0 -64〜63
Mg2 Phase 0 -32〜31
Mg3 Gain 0 -64〜63
Mg3 Phase 0 -32〜31
R1 Gain 0 -64〜63
R1 Phase 0 -32〜31
R2 Gain 0 -64〜63
R2 Phase 0 -32〜31
R3 Gain 0 -64〜63
R3 Phase 0 -32〜31
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Ye1 Gain 0 -64〜63
Ye1 Phase 0 -32〜31
Ye2 Gain  0 -64〜63
Ye2 Phase 0 -32〜31

ON  Page 2/2 0 
G1 Gain 0 -64〜63
G1 Phase 0 -32〜31
G2 Gain 0 -64〜63
G2 Phase 0 -32〜31
G3 Gain 0 -64〜63
G3 Phase 0 -32〜31
Cy1 Gain 0 -64〜63
Cy1 Phase 0 -32〜31
Cy2 Gain 0 -64〜63
Cy2 Phase 0 -32〜31
Cy3 Gain 0 -64〜63
Cy3 Phase 0 -32〜31
B1 Gain 0 -64〜63
B1 Phase 0 -32〜31
B2 Gain  0 -64〜63
B2 Phase 0 -32〜31

 
Sharpness 

Item Initial Value Setting Range 
Scene File 1 Scene File 2 Scene File 3 Scene File 4

Sharpness ON OFF, ON
Level 4 4 2 2 0〜31
Boost Freq. 14MHz 14MHz 16MHz 16MHz 2MHz〜16MHz(2MHz 刻み)
Mode HARD SOFT, HARD
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Scene File 

Item Initial Value Setting Range 
Scene File 1 Scene File 2 Scene File 3 Scene File 4

Load No.1 No.1〜No.4
Save READY READY, No.1〜No.4
Initialize READY READY, No.1〜No.4

 
Function 

Item Initial Value Setting Range 
Scene File 1 Scene File 2 Scene File 3 Scene File 4

Magnifier ×1.0 ×1.0〜×4.0(×0.1 刻み)
Flip OFF OFF, H FLIP, V FLIP, ROTATE
DNR ON OFF, ON
ON  
 2D-DNR Level 5 5 2 2 0〜31

T-DNR Level 0 0〜7
Real Time DPC ON OFF, ON
Adv. Sharpness OFF OFF, ON

ON 
Level 

 
0 

 
0〜255

Picture Effect OFF OFF, CONTRAST, BLOOD, DEFOG
 CONTRAST 

Mode 
 
MIDDLE

 
LOW, MIDDLE, HIGH

BLOOD 
Mode 

 
MIDDLE

 
LOW, MIDDLE, HIGH

DEFOG 
Mode 

 
MIDDLE

 
LOW, MIDDLE, HIGH

Fluorescence OFF OFF, FLUORESCEIN
FLUORESCEIN  

 Red Level 0 -128〜127
Blue Level 0 -128〜127
Green Phase 0 -128〜127
Chroma Level 30 0〜127
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Foot Switch 

Item Initial Value Setting Range 
Scene File 1 Scene File 2 Scene File 3 Scene File 4

Switch1 FREEZE NONE, FREEZE, SCENE F(ROT),H FLIP, V FLIP, 
ROTATE, ZOOM IN, ZOOM OUT, FLUORESCEIN, 
AWB, SCENE 1, SCENE 2, SCENE 3, SCENE 4 
SCENE 1<->2, SCENE 1<->3, SCENE 1<->4, 
SCENE 2<->3, SCENE 2<->4, SCENE 3<->4 

Switch2 FLUORESCEIN 
Switch3 NONE 
Switch4 NONE 

 
Function Key 

Item Initial Value Setting Range 
Scene File 1 Scene File 2 Scene File 3 Scene File 4

Key1 FREEZE NONE, H FLIP, V FLIP, ROTATE, ZOOM IN, 
ZOOM OUT, FLUORESCEIN, FREEZEKey2 FLUORESCEIN
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Video Format 

Item Initial Value Setting Range 
Scene File 1 Scene File 2 Scene File 3 Scene File 4

Frame Rate※1 59.94Hz 59.94Hz, 50Hz
SDI Output※1 1080p 1080p, 1080i
HDMI Output※1 AUTO AUTO, 2K
 2K 

Format※1 
 
1080p RGB444 8bit 

 
1080p RGB444 8bit 
1080p RGB444 10bit 
1080p RGB444 12bit 
1080p YCbCr444 10bit 
1080p YCbCr444 12bit 
1080p YCbCr422 10bit 
1080i RGB444 8bit 
1080i YCbCr422 10bit

HDMI Mode※1 NORMAL NORMAL, DVI
Color Gamut BT.709 BT.709, BT.2020
H Position 0 -32〜32
V Position 0 -8〜8
Genlock OFF OFF, AUTO
AUTO  
 H Phase 0 0〜1023

V Phase 0 0〜1124
3D Support OFF OFF, ON

ON 
Mode 

 
SECONDARY

 
SECONDARY, PRIMARY

Center Marker OFF OFF, ON
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Date/Time 

Item Initial Value Setting Range 
Scene File 1 Scene File 2 Scene File 3 Scene File 4

Year  2000〜2099
Month  1〜12
Day  1〜31
Hours  0〜23
Minutes  0〜59
Seconds  0〜59
Setting READY READY, SET

 
Others 

Item Initial Value Setting Range 
Scene File 1 Scene File 2 Scene File 3 Scene File 4

Initialize READY READY, START
USB Memory READY READY, USB→CCU, CCU→USB
CCU Type※1 SLIT MICRO, SLIT
Language※1 ENGLISH ENGLISH, 中⽂
Cable Length※1 SHORT（SLIT の場合） 

LONG（MICRO の場合）
SHORT, LONG 

Image Priority S/N S/N D-RANGE D-RANGE D-RANGE, S/N
LED Brightness※1 MIDDLE LOW, MIDDLE, HIGH
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エラー/警告表⽰ 
エラーメッセージ⼀覧 

カメラヘッドの接続に関するエラーメッセージ
メッセージ 意味/解決策

Check the Head connection カメラヘッドが接続されていません。 
・ カメラケーブルがしっかり接続されているか確認下さい。 
・ カメラの電源を切り、カメラヘッドと CCU の接続を確認してから、再度

電源を投⼊して下さい。 
・ カメラケーブルを交換下さい。 

（カメラケーブルが断線している可能性があります。） 
 
 
 

オートホワイトバランスに関するエラーメッセージ 
メッセージ 意味/解決策 

AWB Level Over 対象が明るすぎます。 
輝度レベルを下げて下さい。 

AWB Level Under 対象が暗すぎます。 
輝度レベルを上げて下さい。 

AWB Not White 対象内に⽩い領域を検出できません。 
⽩い被写体（ガーゼなど）を映してください。 

AWB Out of Range R ゲインまたは B ゲインの制御範囲を超えています。 
照明を適切な⾊温度に変更下さい。

AWB Error ホワイトバランス調整が⼀定時間内に完了できませんでした。画⾯全体で⽩
い被写体を動かさずに再度 AWB を⾏なって下さい。 

 
 
 

オートホワイトシェーディングに関するエラーメッセージ 
メッセージ 意味/解決策

ERROR 対象の輝度レベルの差が⼤きすぎます。 
照明が被写体全体を照らしていることを確認し、再度実⾏下さい。
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USB メモリー機能に関するエラーメッセージ
メッセージ 意味/解決策

USB File Error 
USB メモリー内のファイル異常を検知しました。 
・ 正常なファイルに差し替えて下さい。 
・ 異常なファイルを削除ください。

USB Memory Error 

USB メモリーへのアクセス中にエラーが発⽣しました。 
・ USB メモリー が CCU にしっかり接続されていることを確認してか

ら、USB メモリー機能を再度実⾏して下さい。 
・ USB メモリーを替えて再度実⾏下さい。

USB Power Overload 

USB ポートの電源異常を検知しました。 
本機の USB ポートは給電には対応しておりません。 
カメラの電源を切り、接続している USB メモリーを直ちに取り外して下さ
い。 

 
 

HDMI に関するエラーメッセージ
メッセージ 意味/解決策

HDMI Power Overload 

HDMI 端⼦の電源異常を検知しました。 
接続した HDMI 機器が要求している電⼒が本機の供給限界を上回っていま
す。 
カメラの電源を切り、接続している HDMI 機器を取り外して下さい。

 
 

ファンに関するエラーメッセージ
メッセージ 意味/解決策

Fan Error!! 
ファンの異常を検知しました。 
ただちにカメラの電源を切り、ご使⽤を⽌めて下さい。 
営業担当にご相談下さい。
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トラブルシューティング 
製品に起こりうる現象の中には故障によるものではない場合がございます。修理をお申し付けになる前にご確認
下さい。 
 
 
よくあるトラブルと対処 
 
起動 

症状 対処
起動しない 電源コードが接続されていることを確認下さい。 

・ 本機側とコンセント側の両⽅を確認下さい。 
解消されない場合は営業担当にお問い合わせ下さい。 

急に停⽌した ⼀度ご使⽤を⽌めて暫く放置してから再起動下さい。 
 
解消した場合、そのまま使い続けると再発や重⼤な破損を招く恐れがあります。
本書に記載の設置条件を満たす環境に直してからご使⽤下さい。 
 
解消されない場合は営業担当にお問い合わせ下さい。 
また設置環境が本書記載の条件を満たしていない場合、修理後も再発する可能性
がございますので設置環境を⾒直し下さい。

 
 
映像 

症状 対処
映像が映らない CCU とモニターが正しく接続されていない可能性があります。 

モニターとの接続をご確認下さい。 
 

ご使⽤のモニターでは本機の映像を映せない可能性があります。 
モニターの仕様をご確認下さい。問題ない場合、ケースによってご対応下さい。

 
1. SDI の映像は映るが HDMI の映像が映らない。 

次をお試し下さい。 
・ HDMI の設定を[AUTO]にする。 
・ HDMI ケーブルを抜き、もう⼀度つなぎ直す。 
・ HDMI ケーブルを交換する。 
解消しない場合は専⾨的な検査が必要です。営業担当にお問い合わせ下さい。 
 
2. HDMI の映像は映るが SDI の映像が映らない。 

次をお試し下さい。 
・ SDI ケーブルを交換する。 
解消しない場合は専⾨的な検査が必要です。営業担当にお問い合わせ下さい。 

 
3. SDI/HDMI ともに映像が映らない。 
専⾨的な検査が必要です。営業担当にお問い合わせください。 
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症状 対処
⿊画⾯しか映らない CCU とモニターの電源が⼊っていない可能性があります。 

電源との接続をご確認下さい。 
 
CCU とモニターが正しく接続されていない可能性があります。 
モニターとの接続をご確認下さい。 
 
モニターのビデオ⼊⼒が接続ラインと⼀致しているかご確認下さい。 
 
シャッターが完全に閉じている可能性があります。 
AE の設定を変更して下さい。

勝⼿にカラーバーになった カメラヘッド-CCU 間で正常な通信ができてないと⾃動的にカラーバーになり
ます。 
スタンバイ状態にしたのち、次をご確認下さい。 
1. カメラケーブルの接続を確認して下さい。 

カメラヘッド側のカメラケーブルがしっかり差し込まれていることを確認
してから、コネクタを回して締めます。 

解消しない場合は、ステップ 2 に進みます。 
 

2. カメラケーブルを交換し、再度ご確認下さい。 
新しいカメラケーブルが必要な場合は、営業担当者にお問い合わせ下さい。

解消しない場合は、ステップ 3 に進みます。 
 

3. 専⾨的な検査が必要です。営業担当にお問い合わせ下さい。 
異物が映っている Real Time DPC の「ON」で対象が消えるかをご確認下さい。 

解消しない場合、専⾨的な検査が必要です。営業担当にお問い合わせ下さい。
 
 
  



90 
 

症状 対処
横線ノイズ、映像の乱れ、な
ど異常な現象が起きる 

1. カメラケーブルの接続をご確認下さい。 
カメラケーブルを曲げたときなどで現象が出るか確認下さい。 
出る場合はケーブルに過剰な負荷がかかっておりますので改善下さい。 
解消されない場合→STEP２へ 

2. 使⽤しているカメラケーブルの⻑さに対し Cable Length の設定が適切か
ご確認下さい。 
解消されない場合→STEP３へ 

3. カメラケーブルを交換しご確認下さい。 
新たなカメラケーブルが必要な場合は営業担当にお問い合わせ下さい。 
解消されない場合→STEP４へ 

4. 本機を周辺機材から離れた場所に移動させて再度ご確認ください。解消され
た場合、周辺機材から電磁波等の影響を受けた可能性があります。 
周辺機材の決められた EMC 対策処置がされているかご確認のうえ為されて
いない場合は実施下さい。 
解消されない場合→STEP5 へ 

5. 専⾨的な検査が必要です。営業担当者にお問い合わせ下さい。
フレームレートを変えたら
⿊画⾯になりメニューも出
なくなった 

選択したフレームレートにモニターが対応していないときに起こります。 
 
メニュー画⾯を閉じずに電源を切り、CCU を再起動して下さい。 
 
それでも映像が映らない場合は営業担当者にお問い合わせ下さい。

 
 
USB 

症状 対処
USB メモリーが認識されな
い 

1. USB メモリーがしっかり差し込まれているかご確認下さい。 
2. 別の USB メモリーをお使い下さい。 

認識中や処理の途中で USB メモリーを抜き差した場合、認識されなくなる
ことがあります。

設定データが保存されない USB メモリーが認識できていない、または容量が⾜りない可能性があります。
別の USB メモリーをお使い下さい。 

USB→CCU で設定が上書き
されない 

USB メモリー内の設定データファイルが破損してないかご確認下さい。 
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